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INTRODUCTION 
The User’s Guide describes the detailed steps necessary to calculate credits and credit obligations for 
credit and debit sites, respectively, for the Nevada Conservation Credit System. 

WHO USES THE USER’S GUIDE 

The User’s Guide is intended for use by the Credit System Administrator, Technical Support Providers 
and Verifiers to calculate credits and credit obligations, and is currently designed with these users in 
mind. This version of the User’s Guide has been made available to the general public, along with data 
required to use the User’s Guide (see Required Data in the Desktop Analysis section), to allow testing of the 
User’s Guide steps. You are encouraged to send any feedback to the Credit System Administrator.  

Using the User’s Guide requires substantial knowledge of sage-grouse biology, moderate GIS capabilities, 
and extensive experience with field data collection methods including identification of Great Basin plant 
species. This expertise may be provided by a single individual or team. In addition, there are specific 
software requirements (as defined at the beginning of each section), including an ESRI ArcGIS license 
with the Spatial Analyst extension and Microsoft Excel 2000 or later. 

HOW TO USE THE USER’S GUIDE 

The User’s Guide is organized into three major steps summarized in Figure 1. All steps should be 
executed in sequence listed below, unless the user has extensive experience and a deep understanding of 
the steps, in order to ensure accurate calculation of credits and credit obligations, and take advantage of 
efficiencies built into the design of the User’s Guide. 

1. Desktop Analysis: The Desktop Analysis should be completed first, because a) the Desktop 
Analysis informs the sampling protocol used in the field analysis, and b) the Desktop Analysis 
pre-screens credit project sites to ensure that they meet the credit site eligibility requirements (see 
the Credit System Manual for more on credit site eligibility) before investing significantly more 
resources to collect field data. 

2. Field Data Collections Methods: The Field Data Collection Methods can be conducted after 
completing Step 1.3 of the Desktop Analysis since map units and sampling intensity guidelines 
will be available after this step. However, it is recommended to complete the entire Desktop 
Analysis before going into the field so that individuals in the field have more knowledge of the 
site and are able to vet all outputs from the Desktop Analysis while in the field, which will 
reduce the likelihood of having to conduct another site visit. Map units may be revised during 
the field visit, which would require portions of the Desktop Analysis to be rerun. 

3. Credit/Credit Obligation Calculation: The complete Credit/Credit Obligation calculation can 
only be performed after completing both the Desktop Analysis and Field Data Collection 
Methods.  It is possible to generate some partial estimates of the credit/credit obligation 
calculation that may be of interest in particular situations (e.g., projected local-scale function, site-
scale habitat function) once required data for those elements are available. 
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Figure 1. Workflow diagram for calculating credits/credit obligations for the Conservation Credit System 

HOW THE USER’S GUIDE RELATES TO THE MANUAL AND HABITAT QUANTIFICATION 
TOOL 

The User’s Guide operationalizes steps, and applies the policy and technical methods defined in the 
Credit System Manual and Habitat Quantification Tool (HQT) Methods Document in order for Technical 
Support Providers, Verifiers and the Credit System Administrator to consistently and efficiently calculate 
credits and credit obligations. 

OPERATIONALIZE STEPS DEFINED IN THE MANUAL 

The User’s Guide describes the detailed steps necessary to consistently and efficiently perform portions of 
the process to generate credits and purchase credits under the Credit System. Section 3: Credit System 
Operations of the Credit System Manual summarizes the process, and the portions of the process covered 
by the User’s Guide are described below. 

For Credit Projects 
The User’s Guide covers step D1 in Section 3.1: Generating Credits of the Nevada Conservation Credit 
System Manual (Figure 2). Before beginning the User’s Guide, a Project Validation Checklist should be 
submitted and approved by the Administrator. Review Section 3: Credit System Operations of the Manual 
for more information. 

 
Figure 2. Overview of the process steps to generate credits 

For Debit Projects 
The User’s Guide covers step B2 in Section 3.2: Acquiring Credits of the Nevada Conservation Credit 
System Manual (Figure 3). Before beginning the User’s Guide, the Credit Obligation Statement with 
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project design information should be submitted to the Administrator. Review Section 3: Credit System 
Operations of the Manual for more information. 

 
Figure 3. Overview of the process to calculate credit obligation and acquire credits 

APPLY POLICY AND TECHNICAL METHODS DEFINED IN THE MANUAL AND HQT 
METHODS DOCUMENT 

The User’s Guide describes the detailed steps necessary to consistently and efficiently apply the policy 
and technical methods defined throughout the Credit System Manual and HQT Methods Document 
when calculating credits and credit obligations. A summary of the Manual and HQT are described below. 

Credit System Manual 
The Credit System Manual describes the policy and technical requirements regarding the calculation, 
transaction, and tracking of credits and debits in the Credit System. Section 2: Policy and Technical Elements 
of the Credit System Manual contains the policy and technical requirements, and is organized by the 
following sections: 

2.1 Program Governance: Describes the governance, enforcement, accounting and adaptive 
management procedures. 
2.2 Habitat Quantification and Credit and Debit Calculation: Describes how to calculate credits, 
debits and credit obligations. 
2.3 Credit Additionality Provisions: Describes requirements that ensure credit projects provide 
benefits beyond those that would be achieved if the project and associated management actions 
had not taken place. 
2.4 Credit Durability Provisions: Describes requirements that ensure credit projects are 
producing expected outcomes for their entire duration. 
2.5 Credit Obligation Provisions and Credit Investment Strategies: Describes requirements that 
ensure credit obligation projects offset the direct and indirect impacts of debit projects. 

Habitat Quantification Tool Methods Document 
The HQT Methods Document defines relevant habitat selection criteria corresponding to sage-grouse 
survival and reproduction at multiple spatial scales. The HQT measures and delineates habitat selection 
criteria using the following four orders, which are defined in substantial detail in Section 3: Habitat 
Quantification Methods and Attributes of the HQT Methods Document:1 

Range-wide: the range for sage-grouse in Nevada;  
Landscape Scale: management areas that have been identified as important for maintaining the 
species at statewide scales (e.g., Priority Habitat Management Areas, General Habitat 
Management Areas, and Other Habitat Management Areas) and the availability of seasonal 
habitats; 
Local Scale: habitat conditions and anthropogenic factors that affect sage-grouse use of, and 
movement between, seasonal use areas within and surrounding the project site; 
Site Scale: habitat conditions at the site of the proposed activities. 

1 Stiver, S.J., E.T Rinkes, and D.E. Naugle. 2010. Sage-grouse Habitat Assessment Framework. U.S. Bureau of Land Management. 
Unpublished Report. U.S. Bureau of Land Management, Idaho State Office, Boise, Idaho. 
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WHAT PRINCIPLES GUIDE THE CALCULATION OF CREDITS AND CREDIT OBLIGATIONS 
WHEN ADDITIONAL CLARITY IS NEEDED 

The following principles guided the development of the process documented in this User’s Guide to 
calculate credits and credit obligations. Users should reference these principles if they need clarity or 
additional guidance when calculating credits or credit obligations for any specific project. 
1. Reflect the concepts and science of the Habitat Quantification Tool methods document accurately 
2. Quantify both direct and indirect impacts of debit projects 
3. Acknowledge the spatially explicit and cumulative nature of impacts to sage-grouse habitat 
4. Evaluate all projects by comparing baseline and post-project condition 
5. Strive for replicability and consistency 
6. Increase ease of use and decrease cost whenever possible without reducing accuracy and 

replicability 
7. Ensure all credit projects generate benefits to sage-grouse proportionate to the impact being offset 
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1. DESKTOP ANALYSIS  

TOOLS REQUIRED 

In order to complete the Desktop Analysis, the following tools are required. 

 ArcGIS version 10.0 or later—Basic (ArcView) license or better is required.  
▫ Spatial Analyst extension for ArcGIS. 
▫ For projects in Nevada, we suggest that the coordinate system used in this analysis is UTM 

Zone 11N, projected in NAD83.  
 Microsoft Excel (2000 or higher). 
 Current Version of the Credit or Debit Project Calculator. 
 Management Plan and Validation Checklist (credit projects only). 
 Recommended: Nevada Conservation Credit System Manual and HQT Scientific Methods 

Document for reference. 

DATA REQUIRED  

The following data should be acquired before beginning the Desktop Analysis.  

1. Download and unzip the NevadaCCSDataPackage_v1_3.zip folder, available 
at https://dcnrftp.ndep.nv.gov.   

Username: SET_public 
Password: SET@1234   

 In this folder, you will find (1) the Nevada CCS Map Package, (2) Anthro_Features.gdb, (3) 
Required_Data_Layers.gdb, and (4) the ‘Layer Files’ folder.  

 The Nevada CCS Map Template (.mxd) can be used as a starting point for completing the 
Desktop Analysis on either Credit or Debit projects; use of the template is optional. 

 Anthro_Features.gdb is a file geodatabase containing existing anthropogenic features to be used 
to assist in delineating anthropogenic features: 
▫ Mines: Federal mine locations derived from Mineral Resource Data System (MRDS) data. 
▫ Oil_Gas: Federal oil and gas well locations derived from Automated Fluid Mineral Support 

System (AFMSS) data dated 12/2012. 
▫ Powerlines: Empty feature class to allow users to more easily delineate powerlines.  
▫ Renewable: Geothermal leases dated 2013. 
▫ Roads: State, federal, and county roads compiled by Nevada Department of Transporation 

(NDOT). 
▫ Towers: Communications tower locations derived from FCC data. 
▫ Urban: Boundaries of census blocks in Nevada categorized based on a Wikipedia search of 

all cities/townships. 
 Required_Data_Layers.gdb contains the following data:  

▫ Anthropogenic Disturbance Attribute Table (Anthro_Attribute_Table): This table provides 
the indirect-effect weights and distances of anthropogenic features. Data in this table is also 
provided in Table 1, further below. 

▫ Distance to Brood-Rearing Habitat (Dist_Brood): This raster layer represents habitat 
function associated with distance to brood-rearing habitats in Nevada. Use to calculate the 
Distance to Brood-Rearing Habitat modifier. 

▫ SEP Management Categories Map (Mgmt_Cat): This feature layer delineates the boundaries 
of Sagebrush Ecosystem Program (SEP) Management Categories in Nevada. Use for 
informing the Credit System’s Mitigation Ratio. 
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▫ Biological Significant Units (NV_BSU): This feature class delineates the boundaries of the 
Biological Significant Units in Nevada. 

▫ Nevada Disturbance Response Groups (NV_DRG) 2: This feature class delineates the 
boundaries of ecological sites that have been grouped into identified disturbance response 
groups. 

▫ Priority Conservation Areas (NV_PCA): This feature class delineates the boundaries of 
Priority Conservation Areas, which are defined as the intersection between Sagebrush Focal 
Areas and (SFA) and Priority Habitat Management Areas (PHMA) in Nevada.  

▫ Population Management Units (NV_PMU): This feature class delineates the boundaries of 
the NDOW Population Management Units in Nevada. 

▫ WAFWA Management Zones (NV_WAFWA): This feature class delineates the boundaries 
of the WAFWA Management Zones in Nevada.  

▫ Precipitation Regime (Precip): This raster layer is reclassified such that areas with less than 
25.4 cm of precipitation are categorized as arid (coded as ‘0’), and areas with greater than 
25.4 cm are categorized as mesic (coded as ‘1’). It is derived from the 30-year normal PRISM 
dataset available at http://prism.oregonstate.edu/normals/. Use for identifying the 
precipitation regime of individual map units.  

▫ Breeding Habitat Suitability Index (Spring_HSI): This raster dataset provides an index of 
local-scale habitat functionality for sage-grouse in Nevada during the spring season, which 
corresponds to the breeding life history period for sage-grouse. 

▫ Late Brood-rearing Habitat Suitability Index (Summer_HSI): This raster dataset provides 
an index of local-scale habitat functionality for sage-grouse in Nevada during the summer 
season, which corresponds to the late brood-rearing life history period for sage-grouse. 

▫ Over-Wintering Habitat Suitability Index (Winter_HSI): This raster dataset provides an 
index of local-scale habitat functionality for sage-grouse in Nevada during the winter 
season, which corresponds to the over-wintering life history period for sage-grouse. 

 Layer Files Folder: Includes layer files that may be used to standardize the symbology of 
outputs of the Desktop Analysis. Instructions for applying symbology to layers using layer files 
are provided throughout the User’s Guide at appropriate steps.   

2. Download Supplemental Data Sources 

▫ NAIP (National Agricultural Imagery Program) imagery: Use as a supplemental data 
source for delineating map units, detecting additional disturbance and verifying 
disturbance from GIS layers. True Color images are available in seamless statewide 
coverage from the following ArcGIS Server 
site: https://gis.apfo.usda.gov/arcgis/rest/services.  

a) To install this ArcServer: click the Add Data button> from the look in menu navigate to 
GIS Server (toward the bottom)> Add ArcGIS Server> Use GIS Services> Next> 
Enter https://gis.apfo.usda.gov/arcgis/rest/services into the internet server box> Finish.  

b) To use the images from the above server: click the Add Data button> navigate to GIS 
Servers> arcgis on gis.apfo.usda.gov> NAIP> Nevada_2015_1m_NC. 

In addition, other aerial imagery sources may be used (e.g., base layers available through 
ArcMap (File>Add Data> Add Basemap).  

2 Disturbance Response Grouping of Ecological Sites Increases Utility of Ecological Sites and State-and-Transition Models for 
Landscape Scale Planning in the Great Basin. Tamzen K. Stringham, Patti Novak-Echenique, Devon K. Snyder, Sarah Peterson, and 
Keirith A. Snyder. Rangelands 2016 38 (6), 371-378 
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▫ Synth Map 2008 (or most recent version):  Use as a supplemental data source for 
delineating map units. Available at http://heritage.nv.gov/node/164. Download the ‘Map 
High Resolution’ and unzip the folder to the desired location. Add the layer file (.lyr) and 
set the data source as the shapefile (.shp). 

▫ SSURGO (Soil Survey Geographic Database): Use the web soil survey data to assist with 
delineating map units based on ecological site descriptions. Available 
at http://websoilsurvey.sc.egov.usda.gov/App/WebSoilSurvey.aspx. Download soils data 
either by navigating to appropriate county and select the most appropriate soils survey 
based on description or by defining area of interest (AOI) and downloading data for the 
AOI. 

▫ USGS Topographic Maps: Use for assistance delineating map units. In ArcMap, go to File> 
‘Add data from ArcGIS Online’. Search for USA Topo. Click “Add” for most recent version. 
Also available at http://nationalmap.gov/ustopo/. 

3. Acquire field data sheets and guidance for the scorecards, located in the Appendices. 

4. Acquire the Proposed Surface Disturbance or Credit Project Boundary shapefile or feature 
layer. This is the area that is being proposed as the debit or credit project, and should be provided 
by the project proponent.  

a. If the proposed surface disturbance or credit project boundary shapefile is not provided, 
follow the steps below to create it. Ensure you have sufficient information to accurately 
digitize this layer. 

For credit projects:  

1. Create a new feature class, type— “Polygon Features”. Name this file 
Credit_Project_Boundary. 

2. Start an editing session by right-clicking on the layer in the Table of Contents, clicking 
‘Edit Features’, then ‘Start Editing’.  

3. Digitize the area of land on which credits can be generated. For example, areas not 
designated within management categories are to be excluded as well as lands not 
eligible to be included in the project. Be sure to save edits and stop editing when done. 

For debit projects:  

1. Create a new feature class, type— “Polygon Features”. Name this file 
Proposed_Surface_Disturbance. 

2. Digitize the outer extent of the proposed surface disturbance, creating separate 
features within the same feature class for each anthropogenic feature subtype 
described in Table 1. Be sure to save edits and stop editing when done. 

5. Acquire the Dist_Lek layer from the Nevada Department of Wildlife by submitting a Data 
Request Form, available from the NDOW website 
at http://www.ndow.org/Nevada_Wildlife/Maps_and_Data/Data/. Provide the 
Credit_Project_Area or Debit_Project_Area layer after completing steps 1.1 and 1.2 of the 
Desktop Analysis as the ‘Project Extent’. Clarify that you are requesting the Dist_Lek layer for 
the purpose of assessing a project site for the Conservation Credit System. 
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ANTHROPOGENIC FEATURES EVALUATED DURING THE DESKTOP ANALYSIS 

Table 1 contains the definitions and indirect-effect weights and distances of anthropogenic features. This table is referenced throughout the Desktop 
Analysis to evaluate impacts from existing and proposed anthropogenic features. It is provided here for quick reference. 

Table 1. Anthropogenic Features Considered in the Nevada Conservation Credit System 

TYPE SUBTYPE WEIGHT 
(%) 

DISTANCE  
(Meters) DEFINITION 

RECOMMENDED  
DATA SOURCE 

Towers  

Communications 75% 6,000 m 
Tall structures designed to support antennas for 

telecommunications and broadcasting. 
Not Available 

Meteorological 75% 6,000 m 
Tall structures designed to support meteorological 

measuring instruments, including those installed to test the 
feasibility of wind farms. 

Not Available 

Powerlines* 
 

 Transmission -  

Distribution 
75% 6,000 m 

Major and minor electrical power transmission and 
distribution lines with cross members, supporting arms, 

etc. Do not include buried transmission lines. 

Hanser, S. (2004). Powerlines in the  
Western United States; in SageMap. 

http://sagemap.wr.usgs.gov/ 
HumanFootprint.aspx 

 
TIGER Line census data 

https://www.census.gov/geo/maps-
data/data/tiger-line.html. 

Monopole 25% 6,000 m 
Monopole distribution lines with no cross members, 

supporting arms, etc. or of a construction that would not 
support raven occupancy 

Mines 

Active - Large  100% 6,000 m Total area of 60 acres or more, active Nevada Department of 
Environmental Protection 

 (included in 
Recommended_Anthro_Data.gdb) 

 
BLM  

Permitted Mines (request from 
appropriate district or field office) 

 
USGS Mineral Resources Online 

Spatial Data 
http://mrdata.usgs.gov/mrds/ 

 

Active - Med or 
Small 

100% 3,000 m Total area less than 60 acres, active 

Inactive - Large 50% 1,000 m 

Total area of 60 acres or more, inactive (no longer removing 
material from the ground and very little, if any, associated 

human activity. Some infrastructure, hard structures, or 
facilities are still present on the site. Do not include 
reclaimed mines or non-reclaimed mines with no 

remaining infrastructure).  

Inactive - Med or 
Small 

10% 1,000 m Total area less than 60 acres, inactive (see above definition 
of inactive). 
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Oil & Gas Wells 
Producing 100% 3,000 m Activity is occurring at the well pads. 

Not Available 
Inactive 0% 0 m Activity is not occurring at the location. 

Pipelines Pipeline n/a n/a 

Pipelines are not captured within the context of 
anthropogenic features on the landscape within the HQT. 
This is primarily due to lack of literature and the temporal 

nature of these features at this point in time. Do not digitize 
pipeline features. 

Not Applicable 

Urban, 
Suburban,  
Ex-Urban 

Development 

Med - High 100% 6,000 m 
Incorporated cities or unincorporated towns with a 

population of 10,000 residents or greater according to the 
latest population data from the State Demographer. 

Sagebrush Ecosystem Program (SEP) 
Urban layer 
(included in 

Recommended_Anthro_Data.gdb) 
 

State Demographer’s Office 
http://nvdemography.org/ 

 

Low 75% 3,000 m 
Incorporated cities or unincorporated towns with a 

population of less than 10,000 residents according to the 
latest population data from the State Demographer. 

Roads 

Interstate 100% 6,000 m Roads with an Interstate functional classification as defined 
by the Federal Highway Administration. 

Nevada Department of 
Transportation 

(included in 
Recommended_Anthro_Data.gdb) 

High Use – Paved 
or Improved; 
Commercial  

100% 3,000 m 

Roads with an Arterial or Major Collector functional 
classification as defined by the Federal Highway 

Administration. Roads to commercial facilities (e.g., mines, 
geothermal plants), which may not necessarily be classified 

by the Federal Highway Administration. 

Low Use – 
Improved; Local 

25% 1,000 m 
Roads with a Minor Collector or Local functional 
classification as defined by the Federal Highway 

Administration. 

Renewable 

Solar 25% 1,000 m Utility-scale solar, geothermal, or wind farm projects and 
any associated above-ground facilities, excluding 

transmission lines connecting to the main grid (categorize 
as ‘Power Lines’). Do not include reclaimed projects or non-

reclaimed projects with no remaining infrastructure. 

Not Available 

Geothermal 100% 6,000 m Not Available 

Wind 25% 6,000 m Not Available 
*The project proponent may request to review and adjust the weight and distance criteria based upon powerline height, construction, perch deterrents 
or other site-specific factors. Any requests must be submitted to the Administrator and approved by the Scientific Committee. 
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STEP-BY-STEP GIS INSTRUCTIONS 

Before you begin, create a new folder for each project evaluated. Name this folder following the 
convention YYMMDD_Project Name. Within that folder, create a new File Geodatabase. In ArcMap, 
open the Catalog window (        ), navigate to the new geodatabase, right click on it and select ‘Make 
Default Database’. You will submit this File Geodatabase to the Credit System Administrator along with 
the Credit or Debit Project Calculator. Optionally, open the Nevada CCS Map Template to begin. 

 

 

 
1.1. Credit Project Boundary or Proposed Surface Disturbance 
In this step, you will generate a layer that contains all anthropogenic features proposed for development or 
modification by the debit or credit project, differentiated and classified by type, subtype, and term of impact. For 
most debit projects, this step entails modifying the data provided by the project proponent to conform to the Credit 
System classifications included in Table 1. 

 

 

1.1.1 Add the Proposed_Surface_Disturbance or Credit_Project_Boundary to ArcMap. 

1.1.2 Using the Copy Features tool, copy the Proposed_Surface_Disturbance or 
Credit_Project_Boundary to the file geodatabase for this project. Name this file 
Proposed_Surface_Disturbance or Credit_Project_Boundary. 

[ArcToolbox> Data Management Tools> Features> Copy Features]  

1.1.3 Remove the original Proposed_Surface_Disturbance or Credit_Project_Boundary from the 
map project. 

 

TIP: When creating folder names and file names, use only letters, numbers, and underscores. Do not 
use other characters. Do not start file names with a number. Some tools will not run properly if 
there are periods, hyphens, or other symbols in the folder or file names. 

 
NOTE: Make sure all layers are projected in a UTM projection coordinate system (Zone 11N) (EPSG 

code 26911) and the GIS extent is in the same working coordinate system. [ArcToolbox> Data 
Management Tools> Projections and Transformations> Project]. 

 
NOTE: This User’s Guide was developed using ArcGIS version 10.4. Tool options may vary between 

versions.   
 

 

 

NOTE: If the Credit_Project_Boundary or Proposed_Surface_Disturbance provided by the project 
proponent is represented by multiple shapefiles, use the Merge tool to merge the shapefiles 
into a single feature class.  
[ArcToolbox> Data Management> General> Merge]  
 Input Datasets = All shapefiles representing the Credit_Project_Boundary or 

Proposed_Surface_Disturbance, 
 Output Dataset = Credit_Project_Boundary or Proposed_Surface_Disturbance, 
 Field Map = leave as default.  

 

 

 

 NOTE:   Ranch headquarters, equipment yards, home sites, etc. should be digitized and excluded as                           
habitat, although they are not considered to be an anthropogenic disturbance.  Treat similarly 
to roads within the project area (separate map unit, no field data collected, but no negative 
impact). 
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1.1.4 For credit projects: If the credit project does not involve modification of existing anthropogenic 

features, skip to step 1.2. Otherwise continue with this step. 

For credit projects that propose to modify existing anthropogenic features: Digitize the 
anthropogenic features to be modified: 

 Create a new feature class, type— “Polygon Features”. Name this layer 1.1.4(a)
Proposed_Modified_Features. 
 Add Fields (1) ‘Type’ and (2) ‘Subtype’, type – “text”. 1.1.4(b)
 Start an editing session by right-clicking on the layer in the Table of Contents, 1.1.4(c)
clicking ‘Edit Features’, then ‘Start Editing’. 
 Digitize the outer extent of the surface disturbance related to the anthropogenic 1.1.4(d)

feature to be modified, creating separate features for each of the anthropogenic 
feature subtypes described in Table 1. Anthropogenic features not described in 
Table 1 are considered ‘de minimus’ and should not be digitized. 
 Populate the ‘Type’ and ‘Subtype’ fields for each feature with the correct data 1.1.4(e)

from Table 1 (see Figure 4 for an example). Be sure to save edits and stop editing 
when done.  
 Using the ‘Join Field’ tool, join the Anthro_Attribute_Table’s ‘Dist’ and ‘Weight’ 1.1.4(f)
field.  

[ArcToolbox> Data Management Tools> Joins> Join Field] 
 Input Table = Proposed_Modified_Features 
 Input Join Field = ‘Subtype’ 
 Input Join Table = Anthro_Attribute_Table 
 Output Join Field = ‘Subtype’ 
 Join Fields = check ‘Dist’ and ‘Weight’ 

For debit projects: Ensure that the Proposed_Surface_Disturbance layer only encompasses 
public lands (only disturbances that require mitigation through consultation are 
required).  

Open the attribute table of the Proposed_Surface_Disturbance. 1.1.4(g)
 Add Fields (1) ‘Type’ and (2) ‘Subtype’, type – “text”; (3) ‘Term’, and (4) ‘Rehab’ 1.1.4(h)

type – “long integer” to the attribute table. 

NOTE: Use the Intersect tool to determine if the Credit_Project_Boundary or 
Proposed_Surface_Disturbance provided by the project proponent contains overlapping 
polygons.  
[ArcTools> Analysis> Overlay> Intersect]  
 Input Features = Credit_Project_Boundary or Proposed_Surface_Disturbance 
 Output Feature Class = append ‘_Merged’ to feature class name 
 Join Attributes = ALL,  
 XY Tolerance = blank,  
 Output Type = INPUT.  

If overlapping polygons are present, remove any areas of overlap: In an editing session, select 
an overlapping polygon. Select the Clip tool in the Editor toolbar (Editor> Clip). A dialog box 
will pop up. Leave the Buffer Distance = 0.0 and select ‘Discard the area that intersects’, then 
click OK. Any polygon portions overlapping the selected polygons will be deleted. Repeat for 
all overlapping polygons.  Consult the project proponent if unsure about how to categorize 
overlapping areas. 
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 Start an editing session by right-clicking on the Proposed_Surface_Disturbance 1.1.4(i)
layer in the Table of Contents, clicking ‘Edit Features’, then ‘Start Editing’.  
 Modify the Proposed_Surface_Disturbance layer so that separate features are 1.1.4(j)
created for each anthropogenic feature subtype described in Table 1 (if necessary). 
If an existing feature will be upgraded from one subtype to another (e.g., changing 
a low-use gravel road to a high-use road), ensure that it is also digitized as a 
feature within the feature layer.  
Populate the ‘Type’ and ‘Subtype’ fields for each feature with the correct data 1.1.4(k)

from Table 1 (see Figure 4 for an example).  
 For anthropogenic features permitted for term impacts, populate the ‘Term’ field 1.1.4(l)
with the four-digit year that the activity at the anthropogenic feature will cease 
(estimate this year if unsure). Populate the ‘Rehab’ field with the four-digit year 
that the surface disturbance will be rehabilitated to pre-project condition. For 
anthropogenic features permitted for permanent impacts, input ‘9999’ in the 
‘Term’ and ‘Rehab’ fields. Be sure to save edits and stop editing when done. 

 Using the ‘Join Field’ tool, join the Anthro_Attribute_Table’s ‘Dist’ and ‘Weight’ 1.1.4(m)
field.  

[ArcToolbox> Data Management Tools> Joins> Join Field] 
 Input Table = Proposed_Modified_Features 
 Input Join Field = ‘Subtype’ 
 Input Join Table = Anthro_Attribute_Table 
 Output Join Field = ‘Subtype’ 
 Join Fields = check ‘Dist’ and ‘Weight’ 

 

 

 
Figure 4. Completed attribute table for the Proposed_Modified_Features layer for credit projects. The 

Proposed_Surface_Disturbance layer for debit projects will look similar, with the addition of ‘Term’ and ‘Rehab’ fields. 

1.2. Project Area 

1.2.1 To determine project area: 

For credit projects: If the credit project does not involve modification of existing 
anthropogenic features, the project area is the same as the Credit_Project_Boundary. Skip 
to step 1.3. 

NOTE: For mining (or renewable energy) facilities, proposed infrastructure such as roads and 
powerlines that are located within or immediately adjacent to anthropogenic features should 
be categorized as mining (or renewable energy) features. Proposed roads or powerlines that 
fall outside of the project footprint, such as those connecting the project to existing 
infrastructure, should be categorized as roads and powerlines.   
 

 

 

TIP: The Proposed_Surface_Disturbance file provided by the project proponent will likely contain 
field codes analogous to the ‘Type’ and ‘Subtype’ fields populated with information from Table 
1. Work with the project proponent to re-categorize the layer using those field codes.  
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For credit projects that propose to modify existing anthropogenic features: 

 Using the Buffer tool, buffer the Proposed_Modified_Features layer based on the 1.2.1(a)
disturbance subtype of the feature(s) to be modified using the ‘Dist’ attribute from 
the attribute table. Name this layer Indirect_Benefits_Area. 

[ArcToolbox> Analysis Tools> Proximity> Buffer] 
 Input Features = Proposed_Modified_Features, 
 Output Feature Class = Indirect_Benefits_Area, 
 Distance = the ‘Dist’ field from the attribute table (select the ‘Field’ radio button and 

choose ‘Dist’ from the dropdown menu), 
 Side Type = FULL,  
 Method = PLANAR,  
 Dissolve Type = ALL, 
 Dissolve Fields = none checked. 

 Using the Union tool, union the Indirect_Benefits_Area with the 1.2.1(b)
Credit_Project_Boundary. Name this layer Credit_Project_Union.  

[ArcToolbox> Analysis> Overlay> Union] 
 Input Datasets = Indirect_Benefits_Area and Credit_Project_Boundary, 
 Output Dataset = Credit_Project_Union, 
 Field Map = leave as default.  

 Using the Dissolve tool, spatially dissolve the Credit_Project_Union layer. Name 1.2.1(c)
this layer Credit_Project_Area. 

[ArcToolbox> Data Management Tools> Generalization> Dissolve] 
 Input Features = Credit_Project_Union, 
 Output Feature Class = Credit_Project_Area, 
 Dissolve Fields = none checked, 
 Statistic Fields = blank, 
 Create multipart features = checked, 
 Unsplit lines = unchecked. 

For debit projects:  

 Using the Buffer tool, buffer the Proposed_Surface_Disturbance based on the 1.2.1(d)
disturbance subtype of the feature(s) to be modified using the ‘Dist’ attribute from 
the attribute table. Name this layer Debit_Project_Area (Figure 5). 

[ArcToolbox> Analysis Tools> Proximity> Buffer] 
 Input Features = Proposed_Surface_Disturbance, 
 Output Feature Class = Debit_Project_Area, 
 Distance = the ‘Dist’ field from the attribute table (select the ‘Field’ radio button and 

choose ‘Dist’ from the dropdown menu), 
 Side Type = FULL,  
 Method = PLANAR,  
 Dissolve Type = ALL, 
 Dissolve Fields = none checked. 
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Figure 5. Proposed_Surface_Disturbance of a geothermal plant and transmission line buffered by the appropriate distance to 

generate the Debit_Project_Area layer 

1.3. Existing & Proposed Surface Disturbance 
In this step, you will digitize all existing surface disturbance associated with anthropogenic features described in 
Table 1 using recommended data sources for help locating and identifying features. You will also combine the 
existing surface disturbance with the proposed surface disturbance (or proposed modified surface disturbance) to 
create a layer that reflects post-project conditions. 

1.3.1 Set the analysis area: 

 Using the Buffer tool, buffer Credit_Project_Area (i.e., Credit_Project_Boundary 1.3.1(a)
for most credit projects) or Debit_Project_Area by 6,000 meters (i.e., the maximum 
indirect effect distance of any anthropogenic feature considered by the Credit 
System). Name this layer Analysis_Area_6000m. 

[ArcToolbox> Analysis Tools> Proximity> Buffer] 
 Input Features = Credit_Project_Boundary, 

Credit_Project_Area, or Debit_Project_Area, 
 Output Feature Class = Analysis_Area_6000m, 
 Distance = 6,000 (in meters) 
 Side Type = FULL,  
 Method = PLANAR,  
 Dissolve Type = ALL, 
 Dissolve Fields = none checked. 

1.3.2 Add data layers of existing anthropogenic features from Anthro_Features.gdb to the map 
project. Ensure that there is a data layer for each anthropogenic feature type listed in Table 
2.The populated layers will be used to help identify anthropogenic features that exist on the 
landscape, although in some instances may reflect only a lease as occurs in the geothermal 
layer or similarly a right-of-way as opposed to an existing on-the-ground disturbance. A 
combination of these layers, the layers referred to in the Recommended Data Sources column in 
Table 1 on pages 13-14, and aerial imagery should be used to identify existing anthropogenic 
features and digitize associated surface disturbance prior to data collection in the field at which 
time all anthropogenic features will be verified or, if not yet found, located and documented 
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properly. Keep in mind the Powerlines layer is merely an empty feature class layer to utilize for 
digitizing all powerlines. To locate all of these structures, we recommend utilization of all 
appropriate data layers, conducting careful swaths along a close-up grid in GIS, contacting 
rural power companies and counties, as well as completing the necessary reconnaissance in the 
field to know the locations of and the classification of all powerlines in the analysis area. In 
general, use the existing data layers for anthropogenic disturbances.  However, powerlines 
need to be identified and digitized in nearly every case.  If an anthropogenic feature (other than 
powerlines) is digitized, consultation with the SETT is required and justification must be added 
to the final verification report.See Appendix 1 for additional steps to use layers within the 
Anthro_Features geodatabase. 

1.3.3 Clip each anthropogenic disturbance type to the Analysis_Area_6000m 

 Using the Clip tool, clip each anthropogenic feature layer (e.g. Mines) to the 1.3.3(a)
Analysis_Area_6000m layer. Name this file Current_Type_Features (e.g. 
Current_Mines_Features) 

[ArcTools> Analysis> Extract> Clip]  
 Input Features = Mines, 
 Clip Features = Analysis_Area_6000m, 
 Output Feature Class = Current_Mines_Features, 
 XY Tolerance = blank.  

 Repeat step 1.3.3(a) for each layer in the Anthro_Features.gdb that occur within 1.3.3(b)
the Analysis_Area_6000m 

1.3.4 For each anthropogenic feature type: 

 Right click on the layer in the Table of Contents, click ‘Edit Features’, then click 1.3.4(a)
‘Start Editing’. 
 Using the most recent NAIP aerial imagery or similar imagery at approximately 1.3.4(b)

1:5000 or finer scale, modify or delineate the outer extent of all surface disturbance 
associated with anthropogenic features of the same type within the analysis area, 
differentiating features by subtype. 

- Refer to Table 1 for definitions of features that should be digitized. Note: Do not 
digitize pipeline right-of-ways as roads, unless the right-of-way contains a road 
that meets the definitions in Table 1. Pipeline right-of-ways are a series of 
connected straight lines. Roads are mostly not perfectly straight lines. 
Anthropogenic features not described in Table 1 are considered ‘de minimus’ 
and should not be digitized.  

- All anthropogenic features should be digitized as polygon features. If you 
prefer, you may digitize linear features such as transmission lines as line 
features, then use the buffer tool to buffer each feature by the appropriate 
distance to create a polygon feature class. Add a ‘Buff_Dist’ field, type— “long 
integer”, to the attribute table as you are digitizing and record half of the 
estimated road or transmission line width in this field (we recommend 5 m for 
powerlines and roads, and 3 m for distribution lines). The buffer is related to the 
width of the transmission or distribution line, not the weight. Use that field as 
the buffer distance in the buffer tool. 

 Confirm and populate the ‘Type’ and ‘Subtype’ for each feature with the correct 1.3.4(c)
data from Table 1. 
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Table 2. Anthropogenic features that should be included in the Project Area. Features in these layers are associated with indirect 
effects that may impact the habitat condition of the Project Area. 

ANTHROPOGENIC FEATURES TO DIGITIZE FILE NAME 

Contained within the Anthro_Features geodatabase: 
Roads* Roads 

Urban, Suburban, and Ex-Urban Development Urban 
Towers Towers 

Powerlines Powerlines 
Mines† Mines 

Oil & Gas Wells Oil_Gas 
Renewable Renewable 

*Note: Any roads leading to commercial facilities should be classified as ‘High_Use’.  
†Note: Consult with the Credit System Administrator if a permitted but currently undeveloped mine is located 
within the Analysis_Area_6000m layer. 

 
1.3.5 Using the Merge tool, merge all anthropogenic feature layers created in steps 1.3.3 together into 

a single feature class. Name this file Current_Anthro_Features.  
[ArcToolbox> Data Management Tools> General> Merge]  
 Input Datasets = All anthropogenic feature layers created in step 1.3.3. 
 Output Dataset = Current_Anthro_Features, 
 Field Map = leave as default (or see Tip Box, below).  

 
1.3.6 Using the ‘Join Field’ tool, join the Anthro_Attribute_Table’s ‘Dist’ and ‘Weight’ field.  

[ArcToolbox> Data Management Tools> Joins> Join Field] 
 Input Table = Current_Anthro_Features 
 Input Join Field = ‘Subtype’ 
 Input Join Table = Anthro_Attribute_Table 
 Output Join Field = ‘Subtype’ 
 Join Fields = check ‘Dist’ and ‘Weight’ 

NOTE: Use the Data Driven Pages feature in ArcGIS to check your work before moving on:  
1. Create a grid index to facilitate review of aerial imagery at approximately 1:5,000 scale.  

[ArcToolbox> Cartography Tools> Data Driven Pages> Grid Index Features] 
 Output Feature Class = a new layer named GridIndexFeatures 
 Input Features = Analysis_Area_6000m 
 Generate Polygon Grid that intersects input feature layers or datasets = checked 
 Use Page Unit and Scale = unchecked 
 Polygon Width = 1000 (in meters) 
 Polygon Height = 1000 (in meters) 
 All other fields = blank 

2. Add the Data Driven Pages toolbar (Customize >Toolbars >Data Driven Pages), then set up data 
driven pages by clicking the Data Driven Page Setup icon (        ) and selecting 
GridIndexFeatures as the Layer. Leave all other options unchanged and click ‘OK’. 

3. Flip through every page using the next page icon (       ) for a thorough review.  

 

TIP: You may delete all fields except for ‘Type’, ‘Subtype’, ‘Dist’ and ‘Weight’ in the Field Map if they 
exist.  
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1.3.7 Label and print a map of all anthropogenic features and attach to the anthropogenic features 
datasheet (Appendix 7). The verifier is responsible for confirming the location of all existing 
anthropogenic features identified using GIS while in the field. Any changes must be properly 
reflected in the Current_Anthro_Features layer. 

1.3.8 Modify the Current_Anthro_Features layer for post-project conditions: 

For credit projects: If anthropogenic features will not be modified as part of the credit 
project, skip to step 1.4. Otherwise, continue with this step. 

For credit projects that propose to modify anthropogenic features:  

 Create a copy of the Current_Anthro_Features layer within the file geodatabase 1.3.8(a)
for this project. Name this file Projected_Anthro_Features. 
 Right click on the layer in the Table of Contents, click ‘Edit Features’, then click 1.3.8(b)

‘Start Editing’. 
 Delete any anthropogenic features from the Projected_Anthro_Features layer that 1.3.8(c)
will be removed by the credit project. Refer to the Proposed_Modified_Features 
layer from step 1.1.4. 
 Modify the attribute table for any anthropogenic features in the 1.3.8(d)

Projected_Anthro_Features layer that will be downgraded from one subtype to 
another (e.g., changing a 2-lane paved road to a low-use gravel road). Be sure to 
save edits and stop editing when done. 

For debit projects that will not upgrade an anthropogenic feature from one subtype to 
another:  

 Using the Merge tool, merge the Current_Anthro_Features layer with the 1.3.8(e)
Proposed_Surface_Disturbance layer. Name this file Projected_Anthro_Features. 
[ArcToolbox> Data Management Tools> General> Merge]  
 Input Datasets = Current_Anthro_Features 

and Proposed_Surface_Disturbance 
 Output Dataset = Projected_Anthro_Features, 
 Field Map = leave as default. 

For debit projects that will upgrade an anthropogenic feature from one subtype to another 
or will be developed within an existing disturbance footprint: 

 Using the Copy Features tool, create a copy of the Current_Anthro_Features layer 1.3.8(f)
within the file geodatabase for this project. Name this file 
Current_Anthro_Features_Copy.  
[Arc Toolbox> Data Management Tools> Features> Copy Features] 
 Input Features = Current_Anthro_Features, 
 Output Feature Class = Current_Anthro_Features_Copy, 
 All other field = blank. 

Right click on the Current_Anthro_Features_Copy layer in the Table of Contents, 1.3.8(g)
click ‘Edit Features’, then click ‘Start Editing’. 
 Delete any anthropogenic features from the Current_Anthro_Features_Copy 1.3.8(h)

layer that will be upgraded from one subtype to another (e.g., changing a low-use 
gravel road to a 2-lane paved road) by the debit project. Also delete any existing 
anthropogenic features that will be replaced by the proposed surface disturbance 
(e.g., an existing meteorological tower that will be replaced by a wind turbine or a 
mine expansion footprint that overlaps with a current mine footprint). Refer to the 
Proposed_Surface_Disturbance layer from step 1.1.1. 
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 Using the Merge tool, merge the Current_Anthro_Features_Copy layer with the 1.3.8(i)
Proposed_Surface_Disturbance layer. Name this file Projected_Anthro_Features. 
[ArcToolbox> Data Management Tools> General> Merge]  
 Input Datasets = Current_Anthro_Features_Copy 

and Proposed_Surface_Disturbance 
 Output Dataset = Projected_Anthro_Features, 
 Field Map = leave as default. 

1.4. Map Unit Delineation 

1.4.1 Eliminate areas categorized as ‘Non-Habitat’ from the Project_Area layer. 
 Using the Clip tool, clip the Project_Area layer (or Credit_Project_Boundary for 1.4.1(a)

most credit projects) to the Mgmt_Cat layer. Name this file Project_Area_Habitat. 
[ArcTools> Analysis> Extract> Clip]  
 Input Features = Credit_Project_Area or Debit_Project_Area, 
 Clip Features = Mgmt_Cat, 
 Output Feature Class = Project_Area_Habitat, 
 XY Tolerance = blank.  

1.4.2 Divide the Project_Area_Habitat layer into discrete map units: 

 
 Open the attribute table of the Project_Area_Habitat layer. 1.4.2(a)
 Add Field (1) ‘Map_Unit_ID’, type— “short integer,” (2) ‘Map_Unit_Name’, 1.4.2(b)

type— “text” and (3) ‘Meadow’, type— “text” to the attribute table. 
 Start an editing session by right-clicking on the layer in the Table of Contents, 1.4.2(c)
clicking ‘Edit Features’, then ‘Start Editing’. 
  Using the Cut Polygon tool  in the Editor Toolbar, delineate map units in the 1.4.2(d)

Project_Area_Habitat layer. 

 
- Before beginning to delineate map units, we recommend referencing the DRG 

layer and grouping the ecological sites into the identified DRGs that are listed in 
the attribute table. (Note: DRGs will not display in the NV CCS Map Template 
if zoomed out beyond a 1:250,000 scale). Use supplemental data sources 
identified in the Data Required section for assistance in meadow delineation and 
other unique features.  

TIP: Ensure that each feature deleted from the Current_Anthro_Features_Copy layer matches the 
surface extent of the equivalent feature in the Proposed_Surface_Disturbance. If necessary, 
using the Cut Polygon tool  in the Editor Toolbar, modify the feature in the 
Current_Anthro_Features_Copy layer to match. For example, if only a segment of an existing 
road will be upgraded from one subtype to another, only delete the segment that will be 
upgraded.  

 

 

TIP: Ensure snapping is enabled (add the Snapping Toolbar if necessary). Also ensure ‘Snap to 
Sketch’ is enabled once in your editing session, this will allow you to create map units that are 
fully contained within one other map unit. 

 

TIP: Useful information about stratification has been developed by the US Department of Agriculture 
(Herrick, et al., 2009, Monitoring Manual for Grassland, Shrubland and Savanna Ecosystems, 
Chapter 2 – “Stratify Land into Monitoring Units”, page 131). 
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- Meadows should be digitized as distinct map units. Meadows are important 
resources for sage-grouse so take care in identifying and delineating all 
meadows within the project area.  

 
- Ignore existing anthropogenic surface disturbance for now. The existing 

anthropogenic surface disturbance you have already digitized will be 
incorporated in the step 1.4.3. 

- See Box 1 on page 28 for more information on map unit delineation. 

 Name map units numerically and record the name in the ‘Map_Unit_ID’ field. 1.4.2(e)
Map units that appear to be very similar, but not adjacent to each other, can 
receive the same numerical name and be considered a single map unit. In the field, 
a visual walk-through should confirm that this is the case. 
 Name each map unit by providing a short description, typically associated with 1.4.2(f)
the major vegetation type, in the ‘Map_Unit_Name’ field. 
For any map units that are meadows, populate the ‘Meadow’ attribute with 1.4.2(g)

‘Altered’ or ‘Unaltered’. For all other map units, populate the ‘Meadow’ attribute 
with ‘No Meadow’. Definitions are provided in the HQT Scientific Methods 
Document. Be sure to save edits and stop editing when done. 

1.4.3 Using the Clip tool, clip the Projected_Anthro_Features layer (if created, see step 1.3.8) or the 
Current_Anthro_Features layer (for most credit projects) to the Project_Area_Habitat layer. 
Name this file Anthro_Features_Clip. 

[ArcTools> Analysis> Extract> Clip]  
 Input Features = Projected_Anthro_Features or Current_Anthro_Features, 
 Clip Features = Project_Area_Habitat, 
 Output Feature Class = Anthro_Features_Clip, 
 XY Tolerance = blank.  

1.4.4 Using the Union tool, union the Project_Area_Habitat layer with the Anthro_Features_Clip 
layer. Name this file Map_Units. 

[ArcTools> Analysis> Overlay> Union]  
 Input Features = Project_Area_Habitat and Anthro_Features_Clip, 
 Output Feature Class = Map_Units, 
 Join Attributes = ALL,  
 XY Tolerance = blank,  
 Gaps Allowed = checked.  

1.4.5 Assign a Map Unit ID for map units of existing surface disturbance in the Map_Units layer: 

 Start an editing session by right clicking on the layer in the Table of Contents, 1.4.5(a)
clicking ‘Edit Features’, then ‘Start Editing’. 
 Open the attribute table. 1.4.5(b)
 Using the Select by Attributes tool (       ), select all features with a <Null> value for 1.4.5(c)
the Rehab attribute, using the expression ‘Rehab IS NULL’. This will select all 
features corresponding to surface disturbance from existing anthropogenic 
disturbance. 
 Replace the Map Unit ID for all selected attribute values with a single Map Unit 1.4.5(d)

ID. We recommend assigning the value of the next sequential Map Unit ID. Also 
change the ‘Meadow’ field to ‘No Meadow’ if necessary. 

TIP: Map units should always be confirmed in the field.  
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1.4.6 For credit projects: Save edits, stop editing, and skip to step 1.4.7. 

For debit projects: Assign a Map Unit ID for map units of proposed surface disturbance in 
the Map_Units layer. 

 Using the Select by Attributes tool (       ), select all features with an equivalent 1.4.6(a)
‘Rehab’ attribute (e.g., all features with ‘Rehab’ of 2025). This will select all features 
corresponding to proposed surface disturbance of the same expected rehabilitation 
date. 

 
 Replace all selected attribute values with a single Map Unit ID. We recommend 1.4.6(b)

assigning the value of the ‘Rehab’ field, if not already assigned (e.g., Map Unit ID = 
2025). 
 Repeat steps 1.4.5(c) to 1.4.5(d) for each unique year in the ‘Rehab’ field, including 1.4.6(c)
‘9999’ for permanent impacts. In this way, all surface disturbances corresponding 
to the same expected rehabilitation date are categorized as the same map unit. This 
will ensure the appropriate number of term debits can be calculated for each phase 
of the project. Be sure to save edits and stop editing when done. 

1.4.7 Using the Dissolve tool, create multipart features in the Map_Units layer before continuing. 
Name this file Map_Units_Dissolve.  

[ArcToolbox> Data Management Tools> Generalization> Dissolve]  
 Input Features = Map_Units, 
 Output Feature Class = Map_Units_Dissolve, 
 Dissolve fields = check ‘Map_Unit_ID’, ‘Map_Unit_Name’, ‘Meadow’, and (for debit 

projects only), ‘Term’, and ‘Rehab’, 
 Statistics fields = blank,  
 Create multipart features = checked, 
 Unsplit lines = blank.  

1.4.8 Calculate area in acres for each map unit:  

 Open attribute table of the Map_Units_Dissolve layer. 1.4.8(a)
 Add Field ‘Acres’, type— “double”, to the attribute table. 1.4.8(b)
 Calculate the area (in acres) of each map unit. Right click on the ‘Acres’ column in 1.4.8(c)
the attribute table and use the Calculate Geometry tool to calculate acres per map 
unit (the coordinate system should be UTM Zone 11N and units in acres) (Figure 
6). 

  
1.5. Precipitation Regime 

 
1.5.1 Ensure the Precip layer from the NevadaCCSDataPackage is added to the map. This layer has 

been classified such that areas with less than 25.4 cm of precipitation are categorized as arid 
(coded as ‘0’), and areas with greater than 25.4 cm are categorized as mesic (coded as ‘1’). 

1.5.2 Determine the precipitation regime for each map unit using PRISM Precipitation Data:  

NOTE: Ignore any values in the ‘Rehab’ field that were auto-generated during the Union processing 
step (e.g., a ‘0’ in the ‘Rehab’ field, which is not a four-digit year.)   
 

 

 

NOTE: Check to ensure that the sum of the acres in the Map_Units_Dissolve layer is equal to the 
sum of the acres in the Map_Units layer. 

 

 
NOTE: Precipitation regime should only be identified for map units that will be sampled in the field.  
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 Open attribute table of the Map_Units_Dissolve layer.  1.5.2(a)
 Add Field ‘Precip’, type— “text”, to the attribute table. 1.5.2(b)
 Start an editing session by right clicking on the layer in the Table of Contents, 1.5.2(c)
clicking ‘Edit Features’, then ‘Start Editing’. 
 Populate the ‘Precip’ field for each map unit with the correct precipitation regime 1.5.2(d)

from the Precip layer. Record if the map unit falls in the ‘arid’ or ‘mesic’ 
precipitation regime. If a map unit spans both precipitation regimes, record the 
dominant regime or split the map unit into two map units. Be sure to save edits 
and stop editing when done.  

1.6. Transect Locations 

 
1.6.1 Select the appropriate number of transects for each map unit based on pilot data or expected 

variance within the map unit. Map units of the same name can be considered as a single map 
unit. See Box 2 on page 30 for help determining number of transects required. We recommend 
generating a few redundant random transect bearings in case the field crews need to take 
additional samples in the field. The map unit containing existing surface disturbance should 
not be sampled, input ‘0’ for the number of transects for that map unit. 

 Open the attribute table of the Map_Units_Dissolve layer. 1.6.1(a)
 Add Field ‘Transects’, type— “short integer”, to the attribute table. 1.6.1(b)
 Start an editing session by right-clicking on the layer in the Table of Contents, 1.6.1(c)
clicking ‘Edit Features’, then ‘Start Editing’. 
 Populate the ‘Transects’ field for each map unit with the number of transects to be 1.6.1(d)

sampled within each map unit according to the necessary sampling intensity. Be 
sure to save edits and stop editing when done (Figure 6). For the map unit 
associated with existing surface disturbance, and any other map units where field 
data will not be collected, input ‘0’. 

 
Figure 6. Completed attribute table for the Map Units layer 

1.6.2 Generate random, spatially distributed locations within each map unit. Name this file 
Transects. Consult with the SETT for large projects to develop a site-specific sampling design 
to generate transects.  

NOTE: Sampling intensity should only be determined for map units that will be sampled in the field. 
For map units where field data will not be collected, input ‘0’ in the ‘Transects’ field. 
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 Using the Create Random Points tool, create random transect locations within 1.6.2(a)

each map unit. Name this file Transects. 
[ArcToolbox> Data Management Tools> Feature Class> Create Random Points] 
 Output Location = the File Geodatabase created for this project, 
 Output Point Feature Class = Transects,  
 Constraining Feature Class = Map_Units_Dissolve layer,  
 Number of Points = ‘Transects’ attribute field of the Map_Units_Dissolve layer, 
 Minimum Allowed Distance = 25 meters, 
 Create Multipoint Output = unchecked. 

 

   
1.6.3 Generate random bearings for each transect. 

 Open attribute table of the Transects layer (created in step 1.6.2). 1.6.3(a)
 Add Field ‘Bearing’, type— “short integer”, to attribute table. 1.6.3(b)
 Use the Field Calculator (right click on the column header to access the Field 1.6.3(c)
Calculator) and type the following expression (ensure ‘Python’ is selected under 
‘Parser’ and check the ‘Show Codeblock’ option): 
 Under Pre-Logic Script Code, type (or copy and paste): 1.6.3(d)

 
 Under Bearing =, type (or copy and paste): 1.6.3(e)

 
 Click OK to run Field Calculator. 1.6.3(f)

 
1.6.4 Calculate the UTM Easting and Northing of each transect: 

 Open the attribute table of the Transects layer. 1.6.4(a)
 Add Fields (1) ‘UTM_E’ and (2) ‘UTM_N’, type— “double”, to attribute table. 1.6.4(b)

TIP: If you have access to the GeoStats extension for ArcGIS, use the Create Spatially Balanced Points 
tool to generate random, spatially balanced transect locations. You may also use the Generalized 
Random Tessalation Stratified (GRTS) function within the Spatial Survey Design & Analysis 
package (spsurvey) in R. See the appropriate documentation for help with those tools. 
Alternatively, use the approach described below. 

 

TIP: Ensure that the Spatial Analyst extension is turned on to use the Create Random Points tool. 
From the top menu, under ‘Customize’, click ‘Extensions’ and ensure Spatial Analyst is checked. 

 
TIP: If too few random points are created, reduce the Minimum Allowed Distance and try again. 

 

def randombearing (min, max): 
   import random 
   return random.randint (min, max)  

randombearing (0, 360) 

NOTE: If the random bearing generated for a transect results in a transect that cannot be sampled by 
field crews, then the next randomly generated point should be used. We recommend 
generating extra random transects and bearings in the event the field crews need to take reject 
transects in the field. All rejections need to be documented and justified.  
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 Right click on the ‘UTM_E’ column in the attribute table and use the Calculate 1.6.4(c)
Geometry tool to calculate the X Coordinate of Point in meters (the coordinate 
system should be UTM Zone 11N and units in meters). 
 Right click on the ‘UTM_N’ column in the attribute table and use the Calculate 1.6.4(d)

Geometry tool to calculate the Y Coordinate of Point in meters (the coordinate 
system should be UTM Zone 11N and units in meters) (Figure 7). 

 
Figure 7. Completed attribute table for the Transects layer 

1.6.5 Using the Spatial Join tool, join the Transects layer to the Map_Units_Dissolve layer. Name 
this file Transects_SpatialJoin. 

[ArcToolbox> Analysis Tools> Overlay> Spatial Join]  
 Target Features = Transects layer,  
 Join Features = Map_Units_Dissolve layer, 
 Output Feature Class = a new feature class named Transects_SpatialJoin, 
 Join Operations = JOIN_ONE_TO_MANY,  
 Keep All Target features = checked,  
 Match Options = WITHIN, 
 Search Radius = blank. 

1.6.6 Export the attribute table of the Transects_SpatialJoin layer to a text file named 
‘Transects_Data’.  

 Open the attribute table of the Transects_SpatialJoin layer. 1.6.6(a)
 Under ‘Table Options’ (             ), select Export and save as a .txt file. Name this file 1.6.6(b)

Transects_Data. 
 When prompted to add the table to the current map, select ‘No’. 1.6.6(c)

1.6.7 Upload transect locations to a GPS unit and print a map with map unit delineations and 
transect start point locations and bearings that should be attached to the map unit datasheets to 
take into the field. See your GPS manufacturer’s instructions for instructions on how to upload 
data to your GPS unit. 
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NOTE: After completing step 1.6, you are now ready to place Pre-Field Work Submittals in a folder 
on the ftp site for SETT Review. This folder should include the completed site validation 
checklist, a brief description of plans for field data collection featuring the lead verifier on the 
project, preliminary dates for field work, and other relevant information, as well as the GIS 
data showing the applicable project area, analysis area boundaries, habitat categories, map 
unit delineation, and transect locations and bearings. A Conflict of Interest Disclosure form 
will also be necessary with this submission. Please download the Pre-Field Submission 
Guidance folder from the ftp site for further details and the necessary forms. After receiving 
permission by the SETT to move forward with data collection in the field, complete Section 2. 
Field Data Collection Method. The field crew will confirm the boundaries of map units, add or 
remove transect locations, and confirm the location of known anthropogenic features as well 
as ensure all powerlines are documented. When field work is complete, make any necessary 
revisions to the Map_Units_Dissolve layer, Transects layer, and Current_Anthro_Features 
layer before continuing with step 1.7.  
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Box 1 | Project Area & Map Units 

Project Area: The project area is the area that is being evaluated, and includes all habitats within the 
boundaries of what is delineated as the project area. For credit projects, the project area is the extent of the 
obligation by the credit developers. For debit projects, the project area is the extent of the proposed 
surface disturbance plus the indirect effects area.  

Map Units: The map units are sub-divisions of the project area based on unique vegetation communities, 
structure, and site potential.  Map units need to be defined in order to capture differences in the site-scale 
habitat attributes assessed to more accurately inform the functional acre scores. See the Field Data 
Collection Methods for a list of attributes assessed. When delineating map units, it is important to keep 
these attributes in mind as they are the 
drivers of the habitat function scores. For 
example, map units should be delineated 
based on expected variation in sagebrush 
canopy cover and distance to sagebrush 
cover. Elevation, slope, aspect, soil type and 
other factors should also be considered, as 
they may impact vegetation distribution. 

Although map units can be somewhat 
subjective, a map unit should encompass a 
relatively homogenous area of vegetation. 
Map units should be delineated based on 
ecological sites, recent aerial photography, 
and ground verification. Major breaks such as 
changes in vegetation community, relative 
abundance of species, water vs. terrestrial, 
shrub land vs. meadow, and roads vs. 
undeveloped area, are relatively straight-
forward to delineate via aerial photography. 
In addition, supplemental data layers within 
GIS can help identify other distinctions such as changes in topography (elevation, slope, and aspect) or 
soils which may affect vegetation composition. Defining map units requires a good working knowledge 
of the habitats important to sage-grouse and local site conditions. If possible, a site visit is encouraged to 
help inform the map unit delineation process prior to initiating the Desktop Analysis. Map unit 
boundaries may also be modified based on site conditions identified during field data collection. If this is 
the case, map unit boundaries should be adjusted (step 1.4) and subsequent steps in the Desktop Analysis 
will need to be repeated. 

Additional rules for map unit delineation: 

 Minimum map unit size should generally be 0.5 acres, unless there are features such as stringer 
meadows that are appropriate to delineate at a smaller scale. 

 If a map unit consisting of meadow habitats are smaller than 0.5 acres or does not calculate a local 
scale habitat function due to the map unit’s shape, then additional steps are needed to calculate 
habitat function within these map units. If this situation occurs, follow step 1.17.  

 Clusters of dense woody riparian vegetation (e.g. willow thickets) within meadows or clusters of 
dense upland shrub cover (e.g. serviceberry, snowberry, and other mountain shrub steppe 
communities) should not be delineated as separate map units. However, transects should not be 
run through vegetation too dense to walk through. If this situation is encountered while vetting 
transects in GIS, discard them.  If this situation is encountered in the field, reflect the transect 90 
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degrees (first right, then left) or pick the next randomly generated transect point with in the map 
unit.   

 For debit projects, map units should first be delineated by indirect disturbance area, proposed 
surface disturbance, and already existing disturbance areas. Indirect and proposed should then 
be further subdivided according to the standards guidelines. No sampling will occur in existing 
disturbance areas, so no further subdivision is needed. This map unit will be assigned a site scale 
score of zero and no transects will be generated in this map unit. 

 For debit projects, term features should be separate map units from permanent features. 
 For credit projects, treatment areas where a change in the site scale score is anticipated should be 

delineated as separate map units. (Even if currently they are similar in vegetation to other areas, 
but a change is not expected in those areas.) 

 

Box 2 | Sampling Intensity 

This section provides guidance for the number of transects per map unit based on area and variability of 
the habitat within the map unit. When delineating map units, the technician should seek to maximize 
map unit area while minimizing variability within each map unit. Once map units are defined, the 
sampling intensity (number of transects per map unit) should be determined based on the acreage of the 
map units and the relative homogeneity of vegetation within the map unit. Table 3 contains the minimum 
number of transects required for each map unit, based on map unit size; however more transects can be 
sampled if determined appropriate due to site specific conditions. When delineating map units using 
aerial imagery, the technician should note which map units have a mosaic of vegetation or patchiness that 
may require a greater level of sampling intensity. Similarly, map units which are more obviously 
homogeneous should be noted as they may require a lower level of sampling intensity.  

Table 3. Minimum number of transects required based on map unit acreage 

Map Unit Size: 0.5 TO <40 
ACRES 

40 TO <640 
ACRES ≥640 ACRES 

Transects per 
Map Unit: 2 - 3* 4 - 8* 8 - 16* 

*Choose the higher end of the range for map units with higher variability. 

In the field, the variability within each map unit will be evaluated before moving on to sample the next 
map unit. If the variability and number of samples does not provide sufficient confidence in the 
parameter estimate for each attribute measured, additional samples will be taken from the map unit. The 
process for generating new transects and calculating the number of additional transects to be sampled is 
described in the Field Data Collections Method section.  

Additional guidance for generating random transect locations and bearings: 

 Transects that are impeded by clusters of willow, riparian woody vegetation or other patches of 
shrubs that are too dense to run a transect through should be discarded and alternative, random 
sample points should be generated. To avoid creating an incentive to modify riparian habitat that 
supports sage-grouse habitats but is not used directly by sage-grouse, and thus does not receive 
credits, clusters of willows or other riparian woody vegetation will receive the habitat function 
score of the map unit that it is contained within. 

 If a transect will cross a map unit boundary into another map unit or outside of the project area, 
the transect will need to be reflected back into the map unit by the field crew and continued. Do 
not discard transects near map unit boundaries, as this would bias results. 

 Do not sample transects that originate in or cross existing surface disturbance. Discard and select 
an alternative, random sample point.  
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 For debit projects with large acreage associated with in Debit or Credit Project Area, contact the 
SETT to develop a site-specific transect sampling area to eliminate inaccessible or difficult to 
access areas.  
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1.7. Management Importance Factor 

1.7.1 Using the Intersect tool, intersect the Map_Units_Dissolve layer with the Mgmt_Cat layer. 
Name this file Current_Mgmt_Cat. 

[ArcTools> Analysis> Overlay> Intersect]  
 Input Features = Map_Units_Dissolve and Mgmt_Cat 
 Output Feature Class = Current_Mgmt_Cat 
 Join Attributes = ALL,  
 XY Tolerance = blank,  
 Output Type = INPUT.  

1.7.2 Calculate proportion of each map unit in each management category: 
 Open the attribute table of the Current_Mgmt_Cat layer. 1.7.2(a)
 Add Field ‘Mgmt_Cat_Acres’, type— “double”, to the attribute table. 1.7.2(b)
 Use the Calculate Geometry tool (right click the column header to access the 1.7.2(c)
Calculate Geometry tool) to calculate the number of acres for each feature in the 
‘Mgmt_Cat_Acres’ field. 
 Add Field ‘Mgmt_Proportion’, type— “double”, to the attribute table. 1.7.2(d)
 Build the following expression using the Field Calculator (right click the column 1.7.2(e)

header to access the Field Calculator) to calculate the proportion of each map unit 
in each management category; check that Mgmt_Proportion values add up to 1 for 
each map unit: 

 
1.7.3 Export the attribute table to a text file named ‘Mgmt_Cats_Data’:  

 Under ‘Table Options’ (             ) select Export and save as a .txt file. Name this file 1.7.3(a)
Mgmt_Cats_Data. 
 When prompted to add the table to the current map, select ‘No’. 1.7.3(b)

1.8. Indirect Impacts from Existing Anthropogenic Features 

1.8.1 For each existing anthropogenic feature subtype present within the Current_Anthro_Features 
layer (created in step 1.3): 

 Using the Euclidean Distance tool, calculate the distance from the nearest feature 1.8.1(a)
of each subtype of each anthropogenic disturbance in the Analysis Area (make sure 
to select a single Subtype by attribute in the Attribute Table): 

[ArcToolbox> Spatial Analyst Tools> Distance> Eucliean Distance] 
 Input raster or feature source data: selected features (based on subtype) of 

Current_Anthro_Features  
 Output distance raster: Current_Type_Subtype_Distance 
 Maximum distance (optional): input D, Distance effect associated with subtype 
 Output cell size (optional): 15 
 Output direction raster (optional): leave blank 

NOTE: Before continuing, you may choose to allow the field crew to field-verify map unit 
delineations and anthropogenic features. If the field crews recommend changes, steps 1.7 
through 1.16 of the Desktop Analysis will need to be repeated. You can complete the Desktop 
Analysis now to estimate the credits or credit obligation of the project, understanding that the 
Desktop Analysis may need to be repeated. Depending on project size and complexity, the 
effort to complete steps 1.7 through 1.16 of the Desktop Analysis is approximately 2 – 4 hours. 

 

Mgmt_Cat_Acres/Acres (of the map unit) 
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 Click on ‘Environments’ at the bottom of the tool window. 
1. Set the ‘Processing Extent’ to be the same as Analysis_Area_6000m. 
2. Set the ‘Snap Raster’ to the Winter_HSI layer (Spring_HSI or Summer_HSI can 

also be used). 
3. Click OK at the bottom of the Environment Settings window and run the tool. 

 For each Anthro_Subtype_Distance layer created in step 1.8.1(a), using the 1.8.1(b)
Map Algebra tool, translate distance to habitat function using the 
anthropogenic disturbance curve: 

[ArcToolbox> Spatial Analyst Tools> Map Algebra> Raster Calculator] 
 

 
Where W: Weight (0 – 1); D: Distance (meters) 

 Output raster = Current_Type_Subtype_Disturbance  
 Click on ‘Environments’ at the bottom of the tool window. 

1. Set the ‘Processing Extent’ to be the same as Analysis_Area_6000m. 
2. Set the ‘Snap Raster’ to a seasonal HSI layer (either Winter_HSI, Spring_HSI or 

Summer_HSI can be used). 
3. Click OK at the bottom of the Environment Settings window and run the tool. 

 For each Anthro_Subtype_Disturbance layer created in step 1.8.1(b), using 1.8.1(c)
the Map Algebra tool, convert Null Values to 1: 

[ArcToolbox> Spatial Analyst Tools> Map Algebra> Raster Calculator] 

 
 Output raster = Current_Type_Subtype_noNull  
 Click on ‘Environments’ at the bottom of the tool window. 

1. Set the ‘Processing Extent’ to be the same as Analysis_Area_6000m. 
2. Set the ‘Snap Raster’ to a seasonal HSI layer (Winter_HSI, Summer_HSI , or 

Spring_HSI). 
3. Click OK at the bottom of the Environment Settings window and run the tool. 

1.8.2 Use the Raster Calculator tool to multiply all layers created in step 1.8.1(c) together to calculate 
the current anthropogenic disturbance, using the equation below. Name this file 
Current_Anthro_Disturbance. 

[ArcToolbox> Spatial Analyst Tools> Map Algebra> Raster Calculator] 

 
 Output raster = Current_Anthro_Disturbance  
 Click on ‘Environments’ at the bottom of the tool window. 

1. Set the ‘Processing extent’ to be the same as Analysis_Area_6000m. 
2. Set the ‘Snap raster’ to be a seasonal HSI layer (Winter_HSI, Summer_HSI, or 

Spring_HSI). 
3. Click OK at the bottom of the Environmental Settings window and run the tool. 

1 - (W * Power((1 - "Current_Type_Subtype_Distance" / D),2)) 
 
 

Con(IsNull(“Current_Type_Subtype_Disturbance”),1, 
“Current_Type_Subtype_Disturbance”) 

‘Current_Type_Subtype_noNull_1’ * ‘Current_Type_Subtype_noNull_2’ * … * 
‘Current_Type_Subtype_noNull_i’ 
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1.9. Indirect Impacts from Projected Anthropogenic Features 

1.9.1 Repeat steps 1.8.1 to 1.8.2, replacing the Current_Anthro_Features layer with the 
Projected_Anthro_Features layer. Name the output of step 1.8.1 
‘Projected_Type_Subtype_Disturbance’. Name the output of step 1.8.2 
Projected_Anthro_Disturbance. 

For debit projects with both term and permanent indirect impacts: Debit projects that 
consist of both temporary activity or infrastructure and permanent activity or 
infrastructure must complete the following steps to calculate debits associated with the 
permanent, indirect impacts. For debit projects with only term or permanent indirect 
impacts (but not both), skip to step 1.10. 

1.9.2 Using the Select tool, select all features from the Projected_Anthro_Features layer except those 
associated with a term impact using the expression ‘Term = 9999 OR Term IS NULL’. Name this 
file Permanent_Anthro_Features. 

[ArcToolbox> Analysis> Extract> Select] 
 Input Features = Projected_Anthro_Features, 
 Output Feature Class = Permanent_Anthro_Features, 
 Expression = use the SQL Query Builder (        ) to select all features except those associated 

with a term impact (i.e., all existing anthropogenic features and all proposed anthropogenic 
features with permanent impacts), 

1.9.3 Repeat steps 1.8.1 to 1.8.2, replacing the Current_Anthro_Features layer with the 
Permanent_Anthro_Features layer. Name the output of step 1.8.1 
‘Permanent_Type_Subtype_Disturbance’. Name the output of step 1.8.2 
Permanent_Anthro_Disturbance. 

 

 
 

TIP: The Current_Anthro_Disturbance raster should be scaled from ≥0 to ≤1 and have the same 
extent as the Analysis_Area_6000m layer. Ensure that this is the case. 

 

 

 

NOTE: For complex debit projects with multiple debit terms, consult with the Credit System 
Administrator to estimate the credit obligation at each phase of the project. 

 
TIP: The Projected_Anthro_Disturbance raster should be scaled from ≥0 to ≤1 and have the same 

extent as the Analysis_Area_6000m layer. Ensure that this is the case. The 
Current_Anthro_Disturbance and Projected_Anthro_Disturbance (if applicable) layer(s) will be 
used to calculate local-scale modifier values in step 1.13. 
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Figure 8. Current_Anthro_Disturbance layer 

 
Figure 9. Projected_Anthro_Disturbance layer 
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1.10. Habitat Suitability Index Score 

1.10.1 Using the Clip Raster tool, clip the Spring_HSI layer to the Analysis_Area_6000m layer (see 
step 1.3.1). Name this layer Current_Spring_HSI. 

[ArcToolbox> Data Management Tools> Raster> Raster Processing> Clip]  
 Input Raster = Spring_HSI 
 Output Extent = Analysis_Area_6000m 
 Use Input Features for Clipping Geometry = checked 
 Output Raster Dataset = Current_Spring_HSI 
 NoData Value = blank 
 Maintain Clipping Extent = unchecked 

1.10.2 Repeat step 1.10.1, replacing the Spring_HSI layer with the Summer_HSI and Winter_HSI 
layers. Name the outputs of step 1.10.1  Current_Summer_HSI and Current_Winter_HSI, 
respectively.  

1.10.3 Using the Zonal Statistics as Table tool, average all pixels of the Current_Spring_HSI layer 
within each map unit. Name the output table ZonalSt_Current_Spring_HSI. 

[ArcToolbox> Spatial Analyst Tools> Zonal> Zonal Statistics as Table] 
 Input raster or feature zone data = Map_Units_Dissolve layer 
 Zone Field = ‘Map_Units_ID’ 
 Input value raster = Current_Spring_HSI 
 Output table = ZonalSt_Current_Spring_HSI 
 Ignore NoData in calculations = checked 
 Statistics type = MEAN 

1.10.4 Repeat step 1.10.3, replacing the Current_Spring_HSI layer with the Current_Summer_HSI 
and Current_Winter_HSI layers. Name the outputs of step 1.10.1  
ZonalSt_Current_Summer_HSI and ZonalSt_Current_Winter_HSI, respectively. 

1.10.5 Using the Join Field tool, join the MEAN field for the ZonalSt_Current_Spring_HSI table to 
the Map_Units_Dissolve layer.  

[ArcToolbox> Data Management Tools> Joins> Join Field] 
 Input Table = Map_Units_Dissolve layer 
 Input Join Field = Map_Unit_ID 
 Join Table = ZonalSt_Current_Spring_HSI 
 Output Join Field = Map_Unit_ID 
 Join Field = check ‘MEAN’. 

1.10.6 Change the field alias to indicate the table from which the field was joined: 

 Open the attribute table of the Map_Units_Dissolve layer. 1.10.6(a)
 Right-click the recently joined field ‘MEAN’ and click ‘Properties’. 1.10.6(b)
 Change the Alias of the field to ‘Current_Spring_HSI’ and click ‘OK’. 1.10.6(c)

 Join Field = check ‘MEAN’. 

1.10.7 Repeat steps 1.10.5 and 1.10.6, replacing the ZonalSt_Current_Spring_HSI layer with the 
ZonalSt_Current_Summer_HSI layer with the ZonalSt_Current_Winter_HSI layers. In step 
1.10.6, change the Alias of the field to ‘Current_Summer_HSI’ and ‘Current_Winter_HSI’. 

For credit projects that propose to modify conifer cover: Please contact and work with the SETT; 
the method is still in development. 
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1.11. Distance to Lek (Breeding) 

1.11.1 Add the Dist_Lek layer to map project, if you haven’t already. 

 
1.12. Distance to Late Brood-Rearing (Breeding) 

1.12.1 Using the Clip Raster tool, clip the Dist_Brood layer to the Project_Area layer. Name this layer 
Current_Dist_Brood. 

[ArcToolbox> Data Management Tools> Raster> Raster Processing> Clip]  
 Input Raster = Dist_Brood 
 Output Extent = Project_Area 
 Use Input Features for Clipping Geometry= checked 
 Output Raster Dataset = Current_Dist_Brood 
 NoData Value = blank 
 Maintain Clipping Extent = unchecked 

 
1.13. Current Local-Scale Habitat Function 
In this step, you will combine the individual modifier layers (e.g., Current_Spring_HSI) together for each seasonal 
habitat type by multiplying the layers together (steps 1.13.1 to 1.13.2). In the next step, you will repeat the process 
for projected conditions, if applicable (step 1.14). 

For breeding habitat: 

1.13.1 Using the Raster Calculator tool, multiply the Current_Anthro_Disturbance layer by the 
Current_Spring_HSI layer, Current_Dist_Lek layer and the Current_Dist_Brood layer to 
calculate local-scale habitat function for breeding habitat using the following expression. Name 
this file Current_Local_Breed. 

 [ArcToolbox> Spatial Analyst Tools> Map Algebra> Raster Calculator 

 
 Ouput raster = Current_Local_Breed 
 Click on ‘Environments’ at the bottom of the tool window. 

1. Set the ‘Processing extent’ to be the same as Analysis_Area_6000m. 
2. Set the ‘Snap raster’ to the Spring_HSI layer. 
3. Click OK at the bottom of the Environmental Settings window and run the tool. 

 
For late brood-rearing and winter habitat: 

1.13.2 Using the Raster Calculator tool, multiply the Current_Anthro_Disturbance layer by the 
Current_Summer_HSI layer to calculate local-scale habitat function for late brood-rearing and 
winter habitat using the following expression. Name this file Current_Local_LBR. 

NOTE: The Dist_Lek layer must be provided by NDOW. See the Data Required section for 
information on how to request this data. The Dist_Lek layer should be scaled from ≥0 to ≤1 
and have the same extent as the Analysis_Area_6000m layer. Ensure that this is the case. The 
Dist_Lek layer will be used to calculate local-scale modifier values in step 1.13. 

 

NOTE: The Current_Dist_Brood layer will be used to calculate local-scale modifier values in step 
1.13. 

Current_Anthro_Disturbance * Current_Spring_HSI * Current_Dist_Lek * 
Current_Dist_Brood 

 

NOTE: The Current_Local_Breed layers should be scaled from ≥0 to ≤1 and have the same extent as 
the Analysis_Area_6000m layer. Ensure that this is the case. 
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 [ArcToolbox> Spatial Analyst Tools> Map Algebra> Raster Calculator 

 
 Ouput raster = Current_Local_LBR 
 Click on ‘Environments’ at the bottom of the tool window. 

1. Set the ‘Processing extent’ to be the same as Analysis_Area_6000m. 
2. Set the ‘Snap raster’ to the Summer_HSI layer. 
3. Click OK at the bottom of the Environmental Settings window and run the tool. 
4. Environmental Settings window and run the tool. 

1.13.3 Repeat step 1.13.1, replacing the Current_Summer_HSI layer with the Current_Winter_HSI 
layer. Name the output of step 1.13.2  Current_Local_Winter.  

 
1.14. Projected Local-Scale Habitat Function 

 
For breeding habitat: 

1.14.1 Using the Raster Calculator tool, multiply the Projected_Anthro_Disturbance layer by the 
Current_Spring_HSI, the Current_Lek_Dist layer and the Current_Dist_Brood layer to 
calculate local-scale habitat function for breeding habitat using the following expression. Name 
this file Projected_Local_Breed. 

[ArcToolbox> Spatial Analyst Tools> Map Algebra> Raster Calculator 

 
 Ouput raster = Projected_Local_Breed 
 Click on ‘Environments’ at the bottom of the tool window. 

1. Set the ‘Processing extent’ to be the same as Analysis_Area_6000m. 
2. Set the ‘Snap raster’ to the Spring_HSI layer. 
3. Click OK at the bottom of the Environmental Settings window and run the tool. 

 
For late brood-rearing and winter and habitat: 

1.14.2 Using the Raster Calculator tool, multiply the Projected_Anthro_Disturbance layer by the 
Current_Summer_HSI layer to calculate local-scale habitat function for late brood-rearing and 
winter habitat using the following expression. Name this file Projected_Local_LBR. 

[ArcToolbox> Spatial Analyst Tools> Map Algebra> Raster Calculator 

 
 Ouput raster = Projected_Local_LBR 

Current_Anthro_Disturbance * Current_Summer_HSI 
 

NOTE: The Current_Local_Winter and Current_Local_LBR layers should be scaled from ≥0 to ≤1 and 
have the same extent as the Analysis_Area_6000m layer. Ensure that this is the case. 

 

NOTE: For credit projects that do not propose to modify landscape or local-scale factors, such as 
anthropogenic features or conifer cover no layers starting with ‘Projected_’ will have been 
created, and this step can be skipped. 

Projected_Anthro_Disturbance * Current_Spring_HSI * Current_Lek_Dist* 
Current_Dist_Brood  

 

NOTE: The Projected_Local_Breed layers should be scaled from ≥0 to ≤1 and have the same extent as 
the Project_Area layer. Ensure that this is the case. 

Projected_Anthro_Disturbance * Current_Summer_HSI 
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 Click on ‘Environments’ at the bottom of the tool window. 
1. Set the ‘Processing extent’ to be the same as Analysis_Area_6000m. 
2. Set the ‘Snap raster’ to any of the Summer_HSI layer. 
3. Click OK at the bottom of the Environmental Settings window and run the tool. 

1.14.3 Repeat step 1.14.2, replacing the Current_Summer_HSI layer with the Current_Winter_HSI. 
Name the output of step 1.14.2  Projected_Local_Winter.  

 
For debit projects with term impacts: 

1.14.4 Repeat steps 1.14.1 to 1.14.3 , replacing the Projected_Anthro_Disturbance layer with the 
Permanent_Anthro_Disturbance layer. Name the output of step 1.14.1 
Permanent_Local_Breed. Name the output of step 1.14.2 Permanent_Local_LBR. Name the 
output of step 1.14.3 Permanent_Local_Winter. 

1.15. Export Data 
In this step, you will average the local-scale modifier layers (e.g., Current_Local_Breed) within each map unit 
using the Zonal Statistics tool (step 1.15.1), join the zonal statistics table to the Map_Units layer (steps 1.15.2 to 
1.15.3), then repeat for each cumulative modifier layer (step 1.15.4). Then, you will export the Map_Units attribute 
table to a text file (step 1.15.5). 

1.15.1 Using the Zonal Statistics as Table tool, average all pixels of the Current_Local_Breed layer 
within each map unit. Name the output table ZonalSt_Current_Breed. 

[ArcToolbox> Spatial Analyst Tools> Zonal> Zonal Statistics as Table] 
 Input raster or feature zone data = Map_Units_Dissolve layer 
 Zone Field = ‘Map_Units_ID’ 
 Input value raster = Current_Local_Breed 
 Output table = ZonalSt_Current_Breed 
 Ignore NoData in calculations = checked 
 Statistics type = MEAN 

1.15.2 Using the Join Field tool, join the MEAN field for the ZonalSt_Current_Breed table to the 
Map_Units_Dissolve layer.  

[ArcToolbox> Data Management Tools> Joins> Join Field] 
 Input Table = Map_Units_Dissolve layer 
 Input Join Field = Map_Unit_ID 
 Join Table = ZonalSt_Current_Breed 
 Output Join Field = Map_Unit_ID 
 Join Field = check ‘MEAN’. 

1.15.3 Change the field alias to indicate the table from which the field was joined: 

Open the attribute table of the Map_Units_Dissolve layer 1.15.3(a)
 Right-click the recently joined field ‘MEAN’ and click ‘Properties’. 1.15.3(b)
 Change the Alias of the field to ‘Current_Breed’ and click ‘OK’. 1.15.3(c)

1.15.4 Repeat step 1.15.1 to 1.15.3 for all local-scale modifier layers created in steps 1.13 to 1.14.  

For debit projects: four or six zonal statistics tables (step 1.15.1) should be created and four 
or six joins (step 1.15.2) should be performed, one each for pre-project and post-project 
conditions (including term and permanent) for breeding and for late brood-rearing and 
winter combined.  

NOTE: The Projected_Local_LBR and Projected_Local_Winter layers should be scaled from ≥0 to ≤1 
and have the same extent as the Analysis_Area_6000m layer. Ensure that this is the case. 
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For credit projects: two or four zonal statistics tables (step 1.15.1) should be created and 
joins (step 1.15.2) should be performed, depending on whether existing anthropogenic 
features, conifer cover, or late brood-rearing habitat will be modified by the project.  

1.15.5 Export the attribute table of the Map_Units_Dissolve layer to a text file named 
‘Map_Unit_Data’: 

 Open the attribute table of the Map_Units_Dissolve layer. 1.15.5(a)
 Under ‘Table Options’ (            ) select Export and save as a .txt file. Name this file 1.15.5(b)
Map_Units_Data. 

 When prompted to add the table to the current map, select ‘No’. 1.15.5(c)

1.16. Enter GIS Data into Credit or Debit Project Calculator 

 
1.16.1 Open the Project Calculator. 

1.16.2 Open a separate instance of Microsoft Excel. 

 
1.16.3 Add the Export Table to the blank workbook: 

 In the Data Ribbon, ‘Get External Data’ section, select ‘From Text’. 1.16.3(a)

 
 Navigate to the Export Table and Open the Export Table. When opening, specify 1.16.3(b)

the file is comma-delimited. 

1.16.4 Copy the relevant columns from the Export Table into the corresponding worksheets and 
columns in the Project Calculator. See Table 4 for a list of Export Tables generated during the 
Desktop Analysis that must be inputted into the Calculator. 

 

 

NOTE: The following instructions are for Microsoft Excel 2010. See relevant help documentation 
online to complete these steps in a different version of Excel.  

TIP: To open a separate instance of Excel (2010 version or earlier), with the Calculator open, go to the 
Start menu and open Excel again. This will allow you to have two visible windows open at the 
same time.  

 

NOTE: Field Aliases, created in steps 1.10.7 and 1.15.3 to indicate the tables from which join fields 
were added, will not be transferred in this step. Refer back to the attribute table of the 
Map_Units layer and rename the column headers in Excel to ‘Current_Spring_HSI’, 
‘Current_Summer_HSI’,  ‘Current_Winter_HSI’, ‘Current_Breed’, ‘Current_LBR’ and 
‘Current_Winter’ and (‘Projected_Breed’, ‘Projected_LBR’ and ‘Projected_Winter’ if 
applicable). 

NOTE: Exported data should include six digits after the decimal point. To ensure consistent results, 
do not round or truncate the results when copying the data into the Project Calculator. Keep 
all six digits after the decimal point. 
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Table 4. Export Tables generated during the Desktop Analysis and corresponding Calculator Worksheet 

 EXPORT TABLE REFERENCE 
STEP CALCULATOR WORKSHEET 

□ Transects_Data 1.6.6 1.2 Enter Transects Data 

□ Mgmt_Cats_Data 1.7.3 1.3 Enter Mgmt Cats Data 

□ Map_Units_Data* 1.15.5 1.1 Enter Map Unit Data 
* If waiting for field data before finishing the Desktop Analysis, complete step 1.15.5 and enter as much data as is 
available into the Calculator in order to calculate site-scale conditions from field data. Mgmt_Cats_Data does not 
need to be entered to generate a site-scale score. 

 
1.16.5 Review the desktop analysis results in worksheet 1.4 Review Desktop Results to ensure desktop 

analysis outputs were properly entered into the Calculator.  

1.17. Current and Projected Local-Scale Habitat Function for Meadow Map Units 
In this step, you will re-calculate the local-scale modifier layers (e.g. Current_Local_Breed) for meadow map units 
that are less than 0.5 acres or are of a shape that did not calculate a local scale habitat function in steps 1.13 and 
1.14. 

1.17.1 In the Map_Units_Dissolve layer, select the Meadow map units that did not calculate a local 
scale habitat function or are smaller than 0.5 acres.  

1.17.2 Using the Buffer tool, buffer the Map_Units_Dissolve layer by 20m (Note: You may need to 
buffer by a greater distance, however we want to use the smallest buffer possible). Name this 
layer Map_Units_Meadows. 

 [ArcToolbox> Analysis Tools> Proximity> Buffer] 
 Input Features = Map_Units_Dissolve, 
 Output Feature Class = Map_Units_Meadows, 
 Distance = 20 (in meters), 
 Side Type = FULL,  
 Method = PLANAR,  
 Dissolve Type = ALL, 
 Dissolve Fields = none checked. 

 
1.17.3 Using the Zonal Statistics as Table tool, average all pixels of the Current_Local_Breed within 

each meadow map unit. Name the output tables as in ZonalSt_Current_Breed_Meadows.  
[ArcToolbox> Spatial Analyst Tools> Zonal> Zonal Statistics as Table] 
 Input raster or feature zone data = Map_Units_Meadows layer 
 Zone Field = ‘Map_Units_ID’ 
 Input value raster = Current_Local_Breed 
 Output table = ZonalSt_Current_Breed_Meadows 
 Ignore NoData in calculations = checked 
 Statistics type = MEAN 

NOTE: The Calculator includes more detailed instructions for how to input data from each field 
datasheet. See rows 1 and 2 in the relevant worksheet in the Calculator.  

 

 

 

 

TIP: You may delete all fields except for ‘Map_Unit_ID’, ‘Map_Unit_Name’, and ‘Meadow’ in the 
Field Map. Ensure that only the meadow map units that did not calculate a local scale habitat 
function are included in the Map_Units_Meadows layer.  
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 Repeat step 1.17.3 above for all local scale modifiers calculated in steps 1.13 – 1.17.3(a)
1.14 

1.17.4 Using the Join Field tool, join the MEAN field for the ZonalSt_Current_Breed_Meadows table 
to the Map_Units_Meadows layer.  

[ArcToolbox> Data Management Tools> Joins> Join Field] 
 Input Table = Map_Units_Meadows layer 
 Input Join Field = Map_Unit_ID 
 Join Table = ZonalSt_Current_Breed_Meadows 
 Output Join Field = Map_Unit_ID 
 Join Field = check ‘MEAN’. 

 Repeat step 1.17.4 above for all Zonal statistics layers calculated in step 1.17.3 1.17.4(a)

1.17.5 Export the attribute table of the Map_Units_Meadows layer to a text file named 
‘Map_Unit_Meadows_Data’: 

 Open the attribute table of the Map_Units_Meadows layer. 1.17.5(a)
 Under ‘Table Options’ (            ) select Export and save as a .txt file. Name this file 1.17.5(b)
Map_Units_Meadows_Data. 

 When prompted to add the table to the current map, select ‘No’. 1.17.5(c)

1.17.6 Add the Export Table to the blank workbook: 

 In the Data Ribbon, ‘Get External Data’ section, select ‘From Text’. 1.17.6(a)
 Navigate to the Export Table and Open the Export Table. When opening, specify 1.17.6(b)

the file is comma-delimited. 
 Copy the relevant columns from the Export Table into the corresponding 1.17.6(c)

worksheets and columns in the Project Calculator. See Table 4 for a list of Export 
Tables generated during the Desktop Analysis that must be inputted into the 
Calculator. 

 Add the local scale modifier data for the meadow map units to the 1.17.6(d)
corresponding map unit IDs in the Map_Units_Data excel file prior to entering the 
data into the HQT calculator. 
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2.  Field Data 
Collection Method 
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2. FIELD DATA COLLECTIONS METHODS 
The methods outlined below must be used for field data collection of attributes associated with the site 
scale, which defines habitat conditions at the site of proposed activities.  Table 5 describes the attributes 
measured to calculate site-scale functional-acres for specified seasonal habitats. 

TIMING OF FIELD DATA COLLECTION 

Vegetation sampling of sage-grouse habitat attributes must be conducted during the peak of the growing 
season. The peak of the growing season on northern Nevada rangeland generally occurs between April 
15th and June 30th. These dates may vary slightly annually due to temperature and precipitation. The 
peak of the growing season varies between sites based upon elevation, latitude, and winter and spring 
precipitation. Take annual and site variations into account when approximating the peak of the growing 
season within the permissible window for the site. Peak growing season is indicated when the culms of 
cool season grasses have fully elongated and seed heads have emerged (not necessarily seed-ripe) and the 
majority of forb species are between early bloom and seed set phenological stages.  

Field data must be collected during the permissible window in order for functional acre scores to be 
official and approved by the Administrator; however shrub data may be collected during any time of 
year. When making repeat visits to a site, attempt to collect data at a phenologically-similar time, or 
within two weeks of the first data collection for the site. 

FIELD MATERIALS REQUIRED 

The following materials should be collected before the field visit: 

1. Credit or Debit Project Calculator 
2. Hand-held sub-meter accuracy GPS unit, preloaded with transect start points 
3. Field maps, using aerial photos as background 
4. Datasheets 
5. Camera 
6. 50-meter tape 
7. Chaining pins 
8. 1-meter tape or wooden ruler 
9. PVC or wooden Daubenmire frame (20X50cm) 

10. White board for photo of transects or photo transect datasheets (Appendix 5)  
11. Rangefinder or 100-meter tape for distance to sagebrush 
12. Plant field guides for the area 
13. Walkie talkies (optional) 
14. Resistance & Resilience Scorecard & Guide, available 

at: http://www.fs.fed.us/rm/pubs/rmrs_gtr322.pdf 
15. A User’s Guide to Assessing Proper Functioning Condition and the Supporting Science for Lentic 

Areas and Lentic Checklist (if applicable), available 
at: http://www.blm.gov/or/programs/nrst/files/Final%20TR%201737-16%20.pdf>  

16. A User’s Guide to Assessing Proper Functioning Condition and the Supporting Science for Lotic 
Areas and Lotic Checklist (if applicable), available 
at: http://www.blm.gov/nstc/library/pdf/Final%20TR%201737-15.pdf>  

17. Ability to Control Wildfire Scorecard: Contact the Sagebrush Ecosystem Technical Team (SETT). 
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Table 5. Attributes measured and summary of data collection methods 

ATTRIBUTE RESOURCE SAGE-GROUSE SEASON  DATA COLLECTION SUMMARY 

Sagebrush canopy 
cover 

 

Cover 
 BREEDING 
 LATE BROOD-REARING The percent canopy cover is estimated 

with line intercept (% of sagebrush 
canopy intersecting transect line).  Cover and 

Foraging  WINTER 

Total shrub canopy 
cover (including 

sagebrush) 
Cover  BREEDING 

The percent canopy cover is estimated 
with line intercept (% of total shrub 
canopy intersecting transect line). 

Sagebrush height 
Cover and 
Foraging 

 WINTER 
The sagebrush height is determined by 
measuring the tallest point of a shrub 
that is intersecting the transect line. 

Distance to 
sagebrush cover Cover -Trigger  LATE BROOD-REARING 

Distance to nearest sagebrush cover 
(cover equivalent to area of at least 
~30x30 m, with density of 10% canopy 
cover, and average height of 30cm) is 
measured from the 30 m point along 
each 50 m transect. 

Perennial forb 
canopy cover  

Foraging 
 BREEDING 
 LATE BROOD-REARING 

Percent cover of perennial forbs is 
determined by sampling within a 
standard-sized Daubenmire plot (20x50 
cm) at 10 meter increments along a 50 
m transect (5 plots total/ transect).  

Forb species 
richness (# of 

species)   
Foraging 

 BREEDING 
 LATE BROOD-REARING 

Abundance of forbs (annual and 
perennial) is determined by sampling 
within a standard-sized Daubenmire 
plot (20x50 cm) at 10 meter increments 
along a 50 m transect (5 plots total/ 
transect).  

Perennial grass 
canopy cover 

Cover-Trigger  BREEDING 
Species and percent cover of perennial 
grasses is determined by sampling 
within a standard-sized area of 
Daubenmire plot (20x50 cm) at 10 
meter increments along a 50 m transect 
(5 plots total/ transect). 

Cover  LATE BROOD-REARING 

Invasive annual 
grass canopy cover 

Modifier 
 BREEDING 
 LATE BROOD-REARING 

Percent cover of annual grasses is 
determined by sampling within a 
standard-sized area of Daubenmire 
plot (20x50 cm) at 10 meter increments 
along a 50 m transect (5 plots total/ 
transect). 
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DETAILED INSTRUCTIONS 

2.1. Conduct Site Reconnaissance 
Upon arrival at the site, field crews should walk the site together to quality-check the map unit 
delineations. Map units, especially in agricultural and meadow areas, often change from year to year, and 
may not reflect even relatively recent aerial photography. As well, changes in some vegetation 
communities may not be evident on aerial photographs, such as understory composition.  Crews should 
be prepared to modify map unit boundaries (both further sub-dividing maps units and conglomerating 
existing maps units) in the field based on observations, and should also come to a common 
understanding of the plants present, and the protocol that follows. Any changes to map units must be 
noted and map unit and relevant GIS data files must be corrected after field work is complete. In 
addition, if sites have high variability that cannot be accounted for through changes in map unit 
delineations, additional transects should be added to the protocol based on the best judgement of the 
verifier.  

2.2. [Repeat Steps 2.3 - 2.11 for each Map Unit] 

2.3. Complete Map Unit Datasheet 
The map unit datasheet should be the first form filled out when arriving at the site and continued to be 
filled out as the sampling is completed (see Appendix 3).  For each map unit, record the date, map unit 
description, and other mandatory information.  The total number of map units sampled within the project 
site should be counted and recorded after all map units have been sampled. 

2.4. Complete Resistance & Resilience Scorecard 
Complete the Resistance and Resilience Score Sheet for each ecological site/map unit within the project 
area (see Field Materials Required, the Resistance & Resilience Scorecard should have been partially filled 
out during the Desktop Analysis), referring to the accompanying field guide3. Once the score cards are 
complete, an area weighted average score for the project site should be calculated and entered into the 
Calculator on the Baseline and Reserve Account tab.  

2.5. Complete Ability to Control Wildfire Scorecard 
Complete Wildfire Score Sheet for each ecological site/map unit within the project area (see Field Materials 
Required, the Wildfire Scorecard should have been partially filled out during the Desktop Analysis), 
referring to the accompanying field guide. Once the score cards are complete, an area weighted average 
score for the project site should be calculated and entered into the Calculator on the Baseline and Reserve 
Account tab.  

2.6. Complete Lentic or Lotic PFC Checklist (if applicable) 
Complete the Lentic or Lotic PFC Assessment Checklists for the credit projects only. 

2.7. [Repeat Steps 2.8 - 2.11 for each Transect] 

2.8. Navigate to Transect and Begin Data Collection 

2.8.1 Establishing a Transect 

 Navigate to a transect start point via hand-held GPS. Insert a chaining pin in the 2.8.1(a)
ground, and lay out or thread a 50-meter transect using the random bearing 
generated for that transect (see step 1.6 in Desktop Analysis). Pull the tape taut and 
anchor the 50 m end with a chaining pin. Populate all fields at the top of transect 

3 Miller, Richard F.; Chambers, Jeanne C.; Pellant, Mike. 2014. A field guide for selecting the most appropriate 
treatment in sagebrush and piñon-juniper ecosystems in the great basin: Evaluating resilience to disturbance and 
resistance to invasive annual grasses, and predicting vegetation response. Gen. Tech. Rep. RMRS-GTR-322 REVISED. 
Fort Collins, CO: U.S. Department of Agriculture, Forest Service, Rocky Mountain Research Station. 66 p. 
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datasheet (Appendix 5), with the date, observer initials, site name, map unit 
number, the transect number and UTMs (including UTM Zone and Datum), GPS 
type, transect bearing, whether the transect is within an altered or unaltered 
meadow, photo point numbers, and camera type. 

 

 
 Transects will be named as followed: XXX-MU#-T#  2.8.1(b)
 XXX is three letter abbreviation for project site, MU# is the map unit number, and 2.8.1(c)
T# is the transect number, all of which should be named based on information 
from the pre-field work desktop analysis.  

2.8.2 Photo Points 

 Using a white board label it with the project site, date, transect name, and transect 2.8.2(a)
direction. Lean it next to the chaining pin it at the 0 meter mark of the transect. 
 Align camera in direction of the transect so that the bottom of the white board is 2.8.2(b)

at the photo’s bottom center (Figure 11). 
 Take photo and, if using GPS camera, name the photo using transect name. 2.8.2(c)

 

 
Figure 10. Transect photo example 

NOTE: If a transect crosses a map unit boundary into another map unit or outside of the project area, 
the transect will need to be reflected back into the map unit by 90 degrees, priority to the 
right, if not, then left. If that doesn’t work pick the next randomly generated point in that map 
unit. 

 
NOTE: If a transect passes through a shrub thicket too dense to sample properly (i.e., willow, 

serviceberry, mahogany, desert peach, etc.) at a distance of greater than 50 m, reflect the 
transect 90 degrees to the right, then left. If reflecting does not work pick the next randomly 

       

 

 

NOTE: For data collection: Always stand on the right side of the transect. Field data should be 
collected on the left side of the transect. 
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2.9. Daubenmire Plots  

2.9.1 Daubenmire Frame Placement 

 Place the top of a Daubenmire frame on the left side of the transect line starting at 2.9.1(a)
the 10 meter mark (see Figure 12). The frame should be placed with the long side 
parallel to the transect.  Take care not to damage any vegetation. Repeat these 
placements every 10 m, for a total of 5 plots along the 50 m transect.  

2.9.2 Grass and Forb Cover 

 Record all grass and forb cover that falls within the plot using the following cover 2.9.2(a)
classes listed in Table 6. If the plant is rooted outside the plot, but its cover falls 
within the plot, those estimates should be counted towards cover. Do not include 
cover of a plant that falls outside of the plot, even if the plant is rooted within the 
plot.  
 Identify cover for each of the following functional group categories: 2.9.2(b)

- PF = perennial forb (live cover only) 
- PG = perennial grass (live or residual) 
- IAG = invasive annual grass (live or residual) 

Table 6. Cover classes for use when estimating cover in Daubenmire frames 

COVER CLASS RANGE OF COVER (%) MID-POINT OF CLASS (%) 

1 0-5 2.5 
2 5-25 15.0 
3 25-50 37.5 
4 50-75 62.5 
5 75-95 85.0 
6 95-100 97.5 

 

NOTE: All species from Line intercept, Daubenmire plots, and general species lists, should be 
recorded using the following nomenclature.  Species names should be recorded using full scientific 
name or the USDA PLANTS database species code (http://plants.usda.gov/). 

If you can identify the genus, but not the species either use the PLANTS database genus code 
(http://plants.usda.gov). ALWAYS define the genus portion of the code in the notes section of the 
transect datasheet (e.g., Artemisia species = AR01). In addition, note if it is annual or perennial for 
forbs and graminoids. 

Do not use common names.  

If you cannot identify the genus, use the following codes and a short description/drawing: 

 AF# = Annual forb (also includes biennials) 
 PF# = Perennial forb 
 AG# = Annual graminoid 
 PG# = Perennial graminoid 
 SH# = Shrub 
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2.9.3 Forb Species Count 

 For each Daubenmire plot, record the USDA PLANT code or scientific name for 2.9.3(a)
each forb species that are rooted within the plot, annual and perennial. Once all 5 
plots are completed for a transect, tally and record the count of all forb species 
identified within the 5 plots, this will give you a total forb species count per 
transect.  
 Record all plant species encountered along the transect in the notes section of the 2.9.3(b)

datasheet.  

2.10. Distance to Sagebrush Cover 

2.10.1 Measure the distance to the nearest sagebrush, or sagebrush mixed shrub community, cover 
from the 30 m mark of the transect and record the distance in meters on the datasheet.  

 Sagebrush or sagebrush mixed shrub community cover must have at least of 10% 2.10.1(a)
canopy cover in a minimum 30x30 m patch size with average height of 30 cm.  

 If the transect is located within sagebrush cover, then record distance as 0 m.  2.10.1(b)

2.11. Line Intercept 

2.11.1 Shrub Canopy Cover 

 You can begin at the 0 m or the 50 m mark for line intercept. For the entire length 2.11.1(a)
of the transect, record start and stop locations (in centimeters) for all shrub species 
intercepting the transect using the following categories:  

- Low sagebrush  
- Big sagebrush  
- Other   

 Interceptions less than 5 cm are not recorded as canopy cover. 2.11.1(b)
 If a gap is greater than 5 cm stop your intercept recording. Resume intercept 2.11.1(c)

once you reach canopy cover that is greater than 5 cm.  
 Canopy cover for each shrub species is recorded, even if multiple species are 2.11.1(d)

overlapping.  

 

NOTE: The following invasive annual grass species should be included, but not limited to, in the 
estimate of annual invasive grass cover:  

 Cheatgrass (Bromus tectorum) 
 Medusahead (Taeniatherum caput-medusae) 
 Red Brome (Bromus rubens) 
 Rattlesnake chess (Bromus briziformis) 

NOTE: The total lengths of shrubs will be added together over the 50 meters to calculate the percent 
canopy cover of sagebrush and total shrubs.  
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2.11.2 Sagebrush Height 

 For each sagebrush plant intercepting the transect, record the tallest vegetative 2.11.2(a)
portion to the nearest cm. Do not include the inflorescence of sagebrush as height. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 11. Diagram of transect and plots 

2.12. Document Anthropogenic Features 

2.12.1 The anthropogenic features map developed in the pre-field desktop analysis should be ground-
truthed on foot or in a vehicle.  Additional features that are identified should be marked on the 
map and digitized in the office in ArcGIS; similarly GPS coordinates collected and recorded in 
the field should be added to ArcGIS in the office.  

2.12.2 Newly identified features should be noted on the anthropogenic features datasheet for the 
project site.  

NOTE: The following sagebrush species are the species of sagebrush in Nevada that the CCS 
recognizes. No other species should be counted as sagebrush. For example, Artemisia spinescens, 
Artemisia ludoviciana, while they are “sage” species, they should not count as sagebrush, but are 
considered as “other” shrub canopy cover.  

 Artemisia arbuscula 
 Artemisia cana 
 Artemisia frigida  
 Artemisia longiloba 
 Artemisia nova 
 Artemisia papposa 
 Artemisia tridentata ssp. tridentata 
 Artemisia tridentata ssp. vaseyana 
 Artemisia tridentata ssp. wyomingensis 
 Artemisia tripartita 
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2.12.2(a) If features are marked on the map, be sure to attach map 
to the anthropogenic features datasheet.  
2.12.2(b) If features are marked using GPS, be sure to record GPS 
unit name and use the following naming code: XXX- # where XXX 
is the three letter abbreviation for project site, and # is a unique 
sequential number for each feature identified in the field. 

2.13. Input Data into Credit or Debit Project Calculator 

 
2.13.1 Open the Project Calculator. 

For each Field Datasheet: 

2.13.2 Enter the relevant data into the corresponding worksheets and columns in the Calculator. See 
Table 7 for a list of field datasheets completed during the field data collection that must be 
inputted into the Calculator. 

Table 7. Field Datasheets completed during the Field Data Collection and corresponding Calculator Worksheet 

 FIELD DATASHEETS REFERENCE 
STEP CALCULATOR WORKSHEET 

□ Map Unit Datasheets 2.3 2.1 Track Field Sheets 

□ Resistance & Resilience Scorecard 2.4 3.1 Enter Baseline & Rsrv Acct 

□ Proper Functioning Condition Checklist 2.5 2.1 Track Field Sheets 

□ Ability to Control Wildfire 2.6 2.1 Track Field Sheets 

□ Transect Datasheets 2.8 - 2.11 
2.2 Enter Field Info 
2.3 Enter Shrub Data 
2.4 Enter Forbs & Grass Data 

 

 
  

DATA REQUIRED: All Field Datasheets completed during the Desktop Analysis, Credit or Debit 
Project Calculator 

NOTE: The Calculator includes more detailed instructions for how to input data from each field 
datasheet. See row 1 in the relevant worksheet in the Calculator.  
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3. CREDIT/CREDIT OBLIGATION CALCULATION 
This section provides a step-by-step overview of the process for generating credits and securing credits to 
offset a credit obligation. These steps will be completed by the Credit Developer/Credit Buyer, Technical 
Service Providers, Verifiers and the Credit System Administrator, depending on their roles and skillsets. 
Please contact the Sagebrush Ecosystem Technical Team (SETT) with questions on any step in this 
process. 

TOOL PREREQUISITES 

 Credit or Debit Project Calculator (NOTE: Section 1: Desktop Analysis and Section 2: Field Data 
Collection Methods contain critical information on completing the Calculator.) 

 Credit Projects 
▫ Validation Checklist (completed) 
▫ Verifier Conflict of Interest Form 
▫ Management Plan 
▫ Participant Contract 
▫ Annual Monitoring Form 
▫ Notice of Validation 

 Debit Projects: 
▫ SETT Consultation Form 
▫ Verifier Conflict of Interest Form 
▫ Anthropogenic Disturbance Review Form 
▫ Verification Contract 
▫ Credit Purchase Agreement 
▫ Credit Transfer Form 
▫ Notice of Transfer 

 Recommended: Current versions of the Nevada Conservation Credit System Manual and HQT 
Methods document for reference. 

DETAILED STEPS TO CALCULATE CREDITS 

The User’s Guide covers steps D2 in Section 3.1: Generating Credits of the Nevada Conservation Credit 
System Manual (Figure 14).  

 
Figure 12. Overview of the process steps to generate credits 

D2.1 CALCULATE PRE-PROJECT CONDITIONS 

3.1. Calculate Credits for Pre-Project Conditions  

3.1.1 Open the Credit Project Calculator. 

3.1.2 Review habitat function and functional acre scores based on current conditions presented in 
worksheet 3.2 Review Credit/Debit Amount to ensure data has been inputted accurately. If not, 
review Section 1: Desktop Analysis or Section 2: Field Data Collection Methods for instructions for 
generating and entering local-scale and site-scale data. 

Select & 
Validate 

Site 

Calculate 
Credit & 

Implement 

Verify 
Conditions 

Register &   
Issue 

Track &   
Transfer 
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3.1.3 Enter relevant WAFWA Management Zone and factors that determine the reserve account 
contribution into worksheet 3.1 Enter Baseline & Rsrv Acct. 

3.1.4 Conduct quality assurance effort by thoroughly reviewing the GIS process and products, 
baseline habitat function, current habitat function, current functional acres, current mitigation 
ratio and current credits generated values in worksheet Summary to ensure values makes sense 
based on general and observational understanding of the project site. 

D2.2 DEFINE & SUBMIT PROJECT DESIGN INFORMATION 

3.2. Complete Section I of the Management Plan 

3.2.1 Complete Section I of the Management Plan according to guidance provided in the form. For 
restoration or enhancement projects, use a draft Management Plan to outline design options for 
the project and describe expected outcomes. These design options will be evaluated in the 
Calculator to calculate expected credits generated by the project. 

3.3. Estimate Post-Project Credits  

3.3.1 In the Calculator, estimate post-project credits by entering projected post-project conditions 
based on project design options in the Management Plan into worksheet 2.7 Enter Projected 
Conditions.  

 Projected post-project conditions are entered into the Projected Post-Project 3.3.1(a)
Habitat Function and Projected Post-Project Mitigation Ratio data entry columns. 
For cells left blank in these data entry columns, the current conditions are used for 
calculating projected post-project conditions. 

3.3.2 Review the projected post-project credit calculations in worksheet Summary. 

3.3.3 Print the updated Credit Summary from worksheet Summary and copy/paste Credit Summary 
into the corresponding section of the draft Management Plan. 

D2.3 IMPLEMENT PROJECT, REFINE CALCULATIONS & SUBMIT 

3.4. Confirm or Refine Credit Calculations 

3.4.1 Implement the project and repeat the credit calculation if the project was not consistent with 
the draft Management Plan. Modify the Calculator and repeat steps in the Desktop Analysis if 
necessary. This is the final, official credit calculation. If changed, print the updated Credit 
Summary from worksheet Summary and copy/paste Credit Summary into the corresponding 
section of the draft Management Plan. 

3.5. Determine Reserve Account Contribution 

3.5.1 Enter the area-weighted Resistance and Resilience scores from the Score Sheets completed in 
step 2.4 into worksheet 3.1 Enter Baseline & Rsrv Acct of the Calculator.  

3.5.2 Enter the area-weighted Ability to Control Wildfire Score Sheet score for the credit project.  

3.5.3 Complete the Competing Land Use assessment and input contribution percentage from Table 8 
for projects on private land into Worksheet 3.1 Enter Baseline & Rsrv Acct of the Calculator. See 
the Management Plan for information necessary to complete the Competing Land Use 
assessment. Projects on public lands have not yet been approved by federal land management 
agencies; please contact the Administrator for more information. 
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Table 8.Competing Land Uses reserve account categories and contribution percentages for credits on privately-owned land 

MINIMUM COMPETING LAND USE RELATED 
REQUIREMENTS 

CONTRIBUTION 
PERCENTAGE 

Participant Contract and  
Conservation Easement and  

Ownership of Subsurface Rights 
0% 

Participant Contract and  
Conservation Easement 1% 

Participant Contract and  
Ownership of Subsurface Rights 

3% 

Participant Contract 4% 
 

 
3.6. Determine Credit Release Schedule 

3.6.1 Review the pre-project credit calculation to the expected post-project credit calculation in 
worksheet Summary.  Use this information to fill out the Credit Release Schedule in Section II of 
the Management Plan. 

3.7. Calculate Financial Assurances 

3.7.1 Complete the management actions table in Section III of the Management Plan to estimate the 
cost for long-term management of the credit project. Use this section to determine the amount 
required for financial assurances for the project. Fill out Section IV of the Management Plan 
with financial assurance information. Contact the Administrator for any needed guidance.  

3.8. Set Verification Schedule 

3.8.1 Complete the independent verification schedule in Section III of the Management Plan. 

3.9. Complete Participant Contract  

3.9.1  Fill out and sign the Participant Contract. 

  

NOTE: After you feel confident in all your results, you are now ready to place Post-Field Work 
Submittals in a folder on the ftp site for SETT Review. This folder should include all GIS data 
within a geodatabase with the appropriate naming conventions, transect datasheets, photo-
point-datasheets, field maps, meaningful notes, anthropogenic disturbance review forms, PFC 
checklists for each riparian area, R&R and Wildfire scorecards representing each map unit, 
the completed HQT calculator indicating the credit estimate, the Verifier Project Assessment 
Submission Form, as well as notes on any assumptions made, potential discrepancies, issues, 
etc. Please download the Post-Field Submission Guidance folder from the ftp site for further 
details and the necessary forms,  
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DETAILED STEPS TO CALCULATE CREDIT OBLIGATION 

The User’s Guide covers steps B2 – B3 in Section 3.2: Acquiring Credits of the Nevada Conservation Credit 
System Manual for regulatory offset credit Buyers only (Figure 15). Before beginning, ensure the project 
has been planned in a way that avoids and minimizes residual impact to the maximum practical extent. 
Review Section 3: Credit System Operations of the Manual for more information. 

 
Figure 13. Overview of the process to calculate credit obligation and acquire credits 

B2.1 DETERMINE CREDIT OBLIGATION AMOUNT 

3.10. Establish Verification Contract 

3.10.1 Complete a Verification Contract with the Credit Buyer. 

3.11. Estimate Credit Obligation 

3.11.1 Open the Debit Project Calculator. 

3.11.2 Review all tabs to ensure data has been inputted accurately. If not, review Section 1: Desktop 
Analysis or Section 2: Field Data Collections Methods for instructions. 

3.11.3 In the Debit Project Calculator, review preliminary credit obligation calculation in worksheet 
Summary. This is the pre-implementation credit obligation estimate. 

3.12. Verify Debit Estimates 

3.12.1 If field data was collected by the Credit Buyer, verify that field data collection was completed 
accurately. 

 
3.13. Verify Post-Project Conditions 

3.13.1 After the project has been implemented, verify that project design plans were followed and that 
the original credit obligation estimate is still accurate. If not, repeat Desktop Analysis steps 
necessary to recalculate credit obligations based on actual post-project conditions. 

3.14. Purchase Credits 

3.14.1 The Credit Buyer will be provided a list of credit projects that could meet the Credit Buyer’s 
credit obligation. The Credit Buyer then selects one or more potential credit projects and 
contacts the Credit Developer. The Credit Developer and Credit Buyer come to agreement on 
credit quantities, price, timing of funding, and other terms. Once an agreement is complete, the 
Credit Buyer or Credit Developer submits the Credit Transfer Form to the Administrator. 

  

NOTE: After you feel confident in all your results, you are now ready to place Post-Field Work 
Submittals in a folder on the ftp site for SETT Review. This folder should include all GIS data 
within a geodatabase with the appropriate naming conventions, transect datasheets, photo-
point-datasheets, field maps, meaningful notes, anthropogenic disturbance review forms, the 
completed HQT calculator indicating the credit estimate, the Verifier Project Assessment 
Submission Form, as well as notes on any assumptions made, potential discrepancies, issues, 
etc. Please download the Post-Field Submission Guidance folder from the ftp site for further 
details and the necessary forms,  
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APPENDICES 
APPENDIX 1. GUIDANCE FOR USING RECOMMENDED ANTHROPOGENIC DATA 

APPENDIX 2. RESISTANCE & RESILIENCE SCORECARD 

APPENDIX 3. MAP UNIT DATASHEET 

APPENDIX 4. ABILITY TO CONTROL WILDFIRE SCORECARD 

APPENDIX 5. TRANSECT DATASHEET 

APPENDIX 6. PHOTO TRANSECT DATASHEET 

APPENDIX 7. ANTHROPOGENIC FEATURES DATASHEET 
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APPENDIX 1. PROTOCOLS FOR USING RECOMMENDED ANTHROPOGENIC DATA 

This appendix provides guidance for the use of datasets provided in the recommended anthropogenic 
data geodatabase in the Nevada Data Package. 

ROADS_LINE (NDOT ROADS LAYER) 

1. Using the Clip tool, clip the Roads_Line layer from the Recommended_Anthro_Data 
geodatabase to the Analysis_Area_6000m layer. Name this file Roads_Line_Clip. 
[ArcTools> Analysis> Extract> Clip]  
 Input Features = Roads_Line, 
 Clip Features = Analysis_Area_6000m, 
 Output Feature Class = Roads_Line_Clip, 
 XY Tolerance = blank.  

2. Digitize any proposed commercial roads not included in the Roads_Line_Clip layer. Commercial 
roads (High Use) are roads that lead to existing anthropogenic features.  They may also be the 
widening, extending, or improvement of existing low use roads or two tracks. 

a. Right click on the layer in the Table of Contents, click ‘Edit Features’, then click ‘Start 
Editing’. 

b. Digitize the probable locations of the center line of the proposed roads that are not 
included in the Roads_Line_Clip layer. 

c. For other roads that are not included in the Roads_Line_Clip layer that meet the 
definitions within Table 1 contact the SETT for consultation. 

d. Populate the ‘Type’, ‘Subtype’, ‘Dist’ and ‘Weight’ field for each feature with the correct 
data from Table 1. Populate the ‘Buff_Dist’ field with an estimate of half of the width of 
the road (i.e., the distance from the center line to the outer extent of the associated surface 
disturbance, including any road shoulder present). Be sure to save edits and stop editing 
when done. 

3. Using the Buffer tool, buffer the Roads_Line_Clip layer using the ‘Buff_Dist’ attribute from the 
attribute table. Name this file Roads. 
[ArcToolbox> Analysis Tools> Proximity> Buffer] 
 Input Features = Roads_Line_Clip 
 Output Feature Class = Roads 
 Distance = the ‘Buff_Dist’ field from the attribute table (select the ‘Field’ radio button and 

choose ‘Buff_Dist’ from the dropdown menu), 
 Side Type = FULL,  
 Method = PLANAR,  
 Dissolve Type = ALL, 
 Dissolve Fields = none checked. 

4. Continue with step 1.3.3 for all other anthropogenic features listed in Table 2.  

URBAN 

1. Using the Clip tool, clip the Urban layer from the Recommended_Anthro_Data geodatabase to 
the Analysis_Area_6000m layer. Name this file Urban_Clip. 
[ArcTools> Analysis> Extract> Clip]  
 Input Features = Urban, 
 Clip Features = Analysis_Area_6000m, 
 Output Feature Class = Urban_Clip, 
 XY Tolerance = blank.  
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2. Continue with step 1.3.3 for all other anthropogenic features listed in Table 2. 

MINES 

1. Using the Clip tool, clip the Mines_Point layer from the Recommended_Anthro_Data 
geodatabase to the Analysis_Area_6000m layer. Name this file Mines_Clip. 
[ArcTools> Analysis> Extract> Clip]  
 Input Features = Mines_Point, 
 Clip Features = Analysis_Area_6000m, 
 Output Feature Class = Mines_Clip, 
 XY Tolerance = blank.  

2. Digitize the outer extent of the surface disturbance associated with any mines in the Mines_Clip 
layer: 

a. Create a new feature class type— “Polygon Features”. Name this file Mines. 
b. Right click on the layer in the Table of Contents, click ‘Edit Features’, then click ‘Start 

Editing’. 
c. Using the most recent NAIP aerial imagery or similar imagery at 1:5000 scale, digitize the 

outer extent of the surface disturbance associated with any mines, including active and 
inactive. See Table 1 for guidance on digitizing mines. 

d. Populate the ‘Type’, ‘Subtype’, ‘Dist’ and ‘Weight’ field for each feature with the correct 
data from Table 1. Be sure to save edits and stop editing when done. 
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Appendix 2. Resistance & Resilience Scorecard 
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Appendix 3: Map Unit Datasheet 
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Appendix 4: Ability to Control Wildfire Scorecard  
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Appendix 5: Transect Datasheet   
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Appendix 6: Photo Transect Datasheet   
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Appendix 7. Anthropogenic Features Datasheet 
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=\\ 

For information and questions about the Nevada Conservation Credit System, please contact: 
 
Sagebrush Ecosystem Technical Team (SETT) 
(775) 684-8600  
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	1.1.4(k) Populate the ‘Type’ and ‘Subtype’ fields for each feature with the correct data from Table 1 (see Figure 4 for an example).
	1.1.4(l) For anthropogenic features permitted for term impacts, populate the ‘Term’ field with the four-digit year that the activity at the anthropogenic feature will cease (estimate this year if unsure). Populate the ‘Rehab’ field with the four-digit...
	1.1.4(m) Using the ‘Join Field’ tool, join the Anthro_Attribute_Table’s ‘Dist’ and ‘Weight’ field.


	1.2. Project Area
	1.2.1 To determine project area:
	For credit projects: If the credit project does not involve modification of existing anthropogenic features, the project area is the same as the Credit_Project_Boundary. Skip to step 1.3.
	For credit projects that propose to modify existing anthropogenic features:
	1.2.1(a) Using the Buffer tool, buffer the Proposed_Modified_Features layer based on the disturbance subtype of the feature(s) to be modified using the ‘Dist’ attribute from the attribute table. Name this layer Indirect_Benefits_Area.
	1.2.1(b) Using the Union tool, union the Indirect_Benefits_Area with the Credit_Project_Boundary. Name this layer Credit_Project_Union.
	1.2.1(c) Using the Dissolve tool, spatially dissolve the Credit_Project_Union layer. Name this layer Credit_Project_Area.

	For debit projects:
	1.2.1(d) Using the Buffer tool, buffer the Proposed_Surface_Disturbance based on the disturbance subtype of the feature(s) to be modified using the ‘Dist’ attribute from the attribute table. Name this layer Debit_Project_Area (Figure 5).


	1.3. Existing & Proposed Surface Disturbance
	1.3.1 Set the analysis area:
	1.3.1(a) Using the Buffer tool, buffer Credit_Project_Area (i.e., Credit_Project_Boundary for most credit projects) or Debit_Project_Area by 6,000 meters (i.e., the maximum indirect effect distance of any anthropogenic feature considered by the Credit...

	1.3.2 Add data layers of existing anthropogenic features from Anthro_Features.gdb to the map project. Ensure that there is a data layer for each anthropogenic feature type listed in Table 2.The populated layers will be used to help identify anthropoge...
	1.3.3 Clip each anthropogenic disturbance type to the Analysis_Area_6000m
	1.3.3(a) Using the Clip tool, clip each anthropogenic feature layer (e.g. Mines) to the Analysis_Area_6000m layer. Name this file Current_Type_Features (e.g. Current_Mines_Features)
	1.3.3(b) Repeat step 1.3.3(a) for each layer in the Anthro_Features.gdb that occur within the Analysis_Area_6000m

	1.3.4 For each anthropogenic feature type:
	1.3.4(a) Right click on the layer in the Table of Contents, click ‘Edit Features’, then click ‘Start Editing’.
	1.3.4(b) Using the most recent NAIP aerial imagery or similar imagery at approximately 1:5000 or finer scale, modify or delineate the outer extent of all surface disturbance associated with anthropogenic features of the same type within the analysis a...
	- Refer to Table 1 for definitions of features that should be digitized. Note: Do not digitize pipeline right-of-ways as roads, unless the right-of-way contains a road that meets the definitions in Table 1. Pipeline right-of-ways are a series of conne...
	- All anthropogenic features should be digitized as polygon features. If you prefer, you may digitize linear features such as transmission lines as line features, then use the buffer tool to buffer each feature by the appropriate distance to create a ...

	1.3.4(c) Confirm and populate the ‘Type’ and ‘Subtype’ for each feature with the correct data from Table 1.

	1.3.5 Using the Merge tool, merge all anthropogenic feature layers created in steps 1.3.3 together into a single feature class. Name this file Current_Anthro_Features.
	1.3.6 Using the ‘Join Field’ tool, join the Anthro_Attribute_Table’s ‘Dist’ and ‘Weight’ field.
	1.3.7 Label and print a map of all anthropogenic features and attach to the anthropogenic features datasheet (Appendix 7). The verifier is responsible for confirming the location of all existing anthropogenic features identified using GIS while in the...
	1.3.8 Modify the Current_Anthro_Features layer for post-project conditions:
	For credit projects: If anthropogenic features will not be modified as part of the credit project, skip to step 1.4. Otherwise, continue with this step.
	For credit projects that propose to modify anthropogenic features:
	1.3.8(a) Create a copy of the Current_Anthro_Features layer within the file geodatabase for this project. Name this file Projected_Anthro_Features.
	1.3.8(b) Right click on the layer in the Table of Contents, click ‘Edit Features’, then click ‘Start Editing’.
	1.3.8(c) Delete any anthropogenic features from the Projected_Anthro_Features layer that will be removed by the credit project. Refer to the Proposed_Modified_Features layer from step 1.1.4.
	1.3.8(d) Modify the attribute table for any anthropogenic features in the Projected_Anthro_Features layer that will be downgraded from one subtype to another (e.g., changing a 2-lane paved road to a low-use gravel road). Be sure to save edits and stop...

	For debit projects that will not upgrade an anthropogenic feature from one subtype to another:
	1.3.8(e) Using the Merge tool, merge the Current_Anthro_Features layer with the Proposed_Surface_Disturbance layer. Name this file Projected_Anthro_Features.
	1.3.8(f) Using the Copy Features tool, create a copy of the Current_Anthro_Features layer within the file geodatabase for this project. Name this file Current_Anthro_Features_Copy.
	1.3.8(g) Right click on the Current_Anthro_Features_Copy layer in the Table of Contents, click ‘Edit Features’, then click ‘Start Editing’.
	1.3.8(h) Delete any anthropogenic features from the Current_Anthro_Features_Copy layer that will be upgraded from one subtype to another (e.g., changing a low-use gravel road to a 2-lane paved road) by the debit project. Also delete any existing anthr...
	1.3.8(i) Using the Merge tool, merge the Current_Anthro_Features_Copy layer with the Proposed_Surface_Disturbance layer. Name this file Projected_Anthro_Features.


	1.4. Map Unit Delineation
	1.4.1 Eliminate areas categorized as ‘Non-Habitat’ from the Project_Area layer.
	1.4.1(a) Using the Clip tool, clip the Project_Area layer (or Credit_Project_Boundary for most credit projects) to the Mgmt_Cat layer. Name this file Project_Area_Habitat.

	1.4.2 Divide the Project_Area_Habitat layer into discrete map units:
	1.4.2(a) Open the attribute table of the Project_Area_Habitat layer.
	1.4.2(b) Add Field (1) ‘Map_Unit_ID’, type— “short integer,” (2) ‘Map_Unit_Name’, type— “text” and (3) ‘Meadow’, type— “text” to the attribute table.
	1.4.2(c) Start an editing session by right-clicking on the layer in the Table of Contents, clicking ‘Edit Features’, then ‘Start Editing’.
	1.4.2(d)  Using the Cut Polygon tool  in the Editor Toolbar, delineate map units in the Project_Area_Habitat layer.
	- Before beginning to delineate map units, we recommend referencing the DRG layer and grouping the ecological sites into the identified DRGs that are listed in the attribute table. (Note: DRGs will not display in the NV CCS Map Template if zoomed out ...
	- Meadows should be digitized as distinct map units. Meadows are important resources for sage-grouse so take care in identifying and delineating all meadows within the project area.
	- Ignore existing anthropogenic surface disturbance for now. The existing anthropogenic surface disturbance you have already digitized will be incorporated in the step 1.4.3.
	- See Box 1 on page 28 for more information on map unit delineation.

	1.4.2(e) Name map units numerically and record the name in the ‘Map_Unit_ID’ field. Map units that appear to be very similar, but not adjacent to each other, can receive the same numerical name and be considered a single map unit. In the field, a visu...
	1.4.2(f) Name each map unit by providing a short description, typically associated with the major vegetation type, in the ‘Map_Unit_Name’ field.
	1.4.2(g) For any map units that are meadows, populate the ‘Meadow’ attribute with ‘Altered’ or ‘Unaltered’. For all other map units, populate the ‘Meadow’ attribute with ‘No Meadow’. Definitions are provided in the HQT Scientific Methods Document. Be ...

	1.4.3 Using the Clip tool, clip the Projected_Anthro_Features layer (if created, see step 1.3.8) or the Current_Anthro_Features layer (for most credit projects) to the Project_Area_Habitat layer. Name this file Anthro_Features_Clip.
	1.4.4 Using the Union tool, union the Project_Area_Habitat layer with the Anthro_Features_Clip layer. Name this file Map_Units.
	1.4.5 Assign a Map Unit ID for map units of existing surface disturbance in the Map_Units layer:
	1.4.5(a) Start an editing session by right clicking on the layer in the Table of Contents, clicking ‘Edit Features’, then ‘Start Editing’.
	1.4.5(b) Open the attribute table.
	1.4.5(c) Using the Select by Attributes tool (       ), select all features with a <Null> value for the Rehab attribute, using the expression ‘Rehab IS NULL’. This will select all features corresponding to surface disturbance from existing anthropogen...
	1.4.5(d) Replace the Map Unit ID for all selected attribute values with a single Map Unit ID. We recommend assigning the value of the next sequential Map Unit ID. Also change the ‘Meadow’ field to ‘No Meadow’ if necessary.

	1.4.6 For credit projects: Save edits, stop editing, and skip to step 1.4.7.
	For debit projects: Assign a Map Unit ID for map units of proposed surface disturbance in the Map_Units layer.
	1.4.6(a) Using the Select by Attributes tool (       ), select all features with an equivalent ‘Rehab’ attribute (e.g., all features with ‘Rehab’ of 2025). This will select all features corresponding to proposed surface disturbance of the same expecte...
	1.4.6(b) Replace all selected attribute values with a single Map Unit ID. We recommend assigning the value of the ‘Rehab’ field, if not already assigned (e.g., Map Unit ID = 2025).
	1.4.6(c) Repeat steps 1.4.5(c) to 1.4.5(d) for each unique year in the ‘Rehab’ field, including ‘9999’ for permanent impacts. In this way, all surface disturbances corresponding to the same expected rehabilitation date are categorized as the same map ...

	1.4.7 Using the Dissolve tool, create multipart features in the Map_Units layer before continuing. Name this file Map_Units_Dissolve.
	1.4.8 Calculate area in acres for each map unit:
	1.4.8(a) Open attribute table of the Map_Units_Dissolve layer.
	1.4.8(b) Add Field ‘Acres’, type— “double”, to the attribute table.
	1.4.8(c) Calculate the area (in acres) of each map unit. Right click on the ‘Acres’ column in the attribute table and use the Calculate Geometry tool to calculate acres per map unit (the coordinate system should be UTM Zone 11N and units in acres) (Fi...


	1.5. Precipitation Regime
	1.5.1 Ensure the Precip layer from the NevadaCCSDataPackage is added to the map. This layer has been classified such that areas with less than 25.4 cm of precipitation are categorized as arid (coded as ‘0’), and areas with greater than 25.4 cm are cat...
	1.5.2 Determine the precipitation regime for each map unit using PRISM Precipitation Data:
	1.5.2(a) Open attribute table of the Map_Units_Dissolve layer.
	1.5.2(b) Add Field ‘Precip’, type— “text”, to the attribute table.
	1.5.2(c) Start an editing session by right clicking on the layer in the Table of Contents, clicking ‘Edit Features’, then ‘Start Editing’.
	1.5.2(d) Populate the ‘Precip’ field for each map unit with the correct precipitation regime from the Precip layer. Record if the map unit falls in the ‘arid’ or ‘mesic’ precipitation regime. If a map unit spans both precipitation regimes, record the ...


	1.6. Transect Locations
	1.6.1 Select the appropriate number of transects for each map unit based on pilot data or expected variance within the map unit. Map units of the same name can be considered as a single map unit. See Box 2 on page 30 for help determining number of tra...
	1.6.1(a) Open the attribute table of the Map_Units_Dissolve layer.
	1.6.1(b) Add Field ‘Transects’, type— “short integer”, to the attribute table.
	1.6.1(c) Start an editing session by right-clicking on the layer in the Table of Contents, clicking ‘Edit Features’, then ‘Start Editing’.
	1.6.1(d) Populate the ‘Transects’ field for each map unit with the number of transects to be sampled within each map unit according to the necessary sampling intensity. Be sure to save edits and stop editing when done (Figure 6). For the map unit asso...

	1.6.2 Generate random, spatially distributed locations within each map unit. Name this file Transects. Consult with the SETT for large projects to develop a site-specific sampling design to generate transects.
	1.6.2(a) Using the Create Random Points tool, create random transect locations within each map unit. Name this file Transects.

	1.6.3 Generate random bearings for each transect.
	1.6.3(a) Open attribute table of the Transects layer (created in step 1.6.2).
	1.6.3(b) Add Field ‘Bearing’, type— “short integer”, to attribute table.
	1.6.3(c) Use the Field Calculator (right click on the column header to access the Field Calculator) and type the following expression (ensure ‘Python’ is selected under ‘Parser’ and check the ‘Show Codeblock’ option):
	1.6.3(d) Under Pre-Logic Script Code, type (or copy and paste):
	1.6.3(e) Under Bearing =, type (or copy and paste):
	1.6.3(f) Click OK to run Field Calculator.

	1.6.4 Calculate the UTM Easting and Northing of each transect:
	1.6.4(a) Open the attribute table of the Transects layer.
	1.6.4(b) Add Fields (1) ‘UTM_E’ and (2) ‘UTM_N’, type— “double”, to attribute table.
	1.6.4(c) Right click on the ‘UTM_E’ column in the attribute table and use the Calculate Geometry tool to calculate the X Coordinate of Point in meters (the coordinate system should be UTM Zone 11N and units in meters).
	1.6.4(d) Right click on the ‘UTM_N’ column in the attribute table and use the Calculate Geometry tool to calculate the Y Coordinate of Point in meters (the coordinate system should be UTM Zone 11N and units in meters) (Figure 7).

	1.6.5 Using the Spatial Join tool, join the Transects layer to the Map_Units_Dissolve layer. Name this file Transects_SpatialJoin.
	1.6.6 Export the attribute table of the Transects_SpatialJoin layer to a text file named ‘Transects_Data’.
	1.6.6(a) Open the attribute table of the Transects_SpatialJoin layer.
	1.6.6(b) Under ‘Table Options’ (             ), select Export and save as a .txt file. Name this file Transects_Data.
	1.6.6(c) When prompted to add the table to the current map, select ‘No’.

	1.6.7 Upload transect locations to a GPS unit and print a map with map unit delineations and transect start point locations and bearings that should be attached to the map unit datasheets to take into the field. See your GPS manufacturer’s instruction...

	1.7. Management Importance Factor
	1.7.1 Using the Intersect tool, intersect the Map_Units_Dissolve layer with the Mgmt_Cat layer. Name this file Current_Mgmt_Cat.
	1.7.2 Calculate proportion of each map unit in each management category:
	1.7.2(a) Open the attribute table of the Current_Mgmt_Cat layer.
	1.7.2(b) Add Field ‘Mgmt_Cat_Acres’, type— “double”, to the attribute table.
	1.7.2(c) Use the Calculate Geometry tool (right click the column header to access the Calculate Geometry tool) to calculate the number of acres for each feature in the ‘Mgmt_Cat_Acres’ field.
	1.7.2(d) Add Field ‘Mgmt_Proportion’, type— “double”, to the attribute table.
	1.7.2(e) Build the following expression using the Field Calculator (right click the column header to access the Field Calculator) to calculate the proportion of each map unit in each management category; check that Mgmt_Proportion values add up to 1 f...

	1.7.3 Export the attribute table to a text file named ‘Mgmt_Cats_Data’:
	1.7.3(a) Under ‘Table Options’ (             ) select Export and save as a .txt file. Name this file Mgmt_Cats_Data.
	1.7.3(b) When prompted to add the table to the current map, select ‘No’.


	1.8. Indirect Impacts from Existing Anthropogenic Features
	1.8.1 For each existing anthropogenic feature subtype present within the Current_Anthro_Features layer (created in step 1.3):
	1.8.1(a) Using the Euclidean Distance tool, calculate the distance from the nearest feature of each subtype of each anthropogenic disturbance in the Analysis Area (make sure to select a single Subtype by attribute in the Attribute Table):
	1.8.1(b) For each Anthro_Subtype_Distance layer created in step 1.8.1(a), using the Map Algebra tool, translate distance to habitat function using the anthropogenic disturbance curve:
	1.8.1(c) For each Anthro_Subtype_Disturbance layer created in step 1.8.1(b), using the Map Algebra tool, convert Null Values to 1:

	1.8.2 Use the Raster Calculator tool to multiply all layers created in step 1.8.1(c) together to calculate the current anthropogenic disturbance, using the equation below. Name this file Current_Anthro_Disturbance.

	1.9. Indirect Impacts from Projected Anthropogenic Features
	1.9.1 Repeat steps 1.8.1 to 1.8.2, replacing the Current_Anthro_Features layer with the Projected_Anthro_Features layer. Name the output of step 1.8.1 ‘Projected_Type_Subtype_Disturbance’. Name the output of step 1.8.2 Projected_Anthro_Disturbance.
	For debit projects with both term and permanent indirect impacts: Debit projects that consist of both temporary activity or infrastructure and permanent activity or infrastructure must complete the following steps to calculate debits associated with t...
	1.9.2 Using the Select tool, select all features from the Projected_Anthro_Features layer except those associated with a term impact using the expression ‘Term = 9999 OR Term IS NULL’. Name this file Permanent_Anthro_Features.
	1.9.3 Repeat steps 1.8.1 to 1.8.2, replacing the Current_Anthro_Features layer with the Permanent_Anthro_Features layer. Name the output of step 1.8.1 ‘Permanent_Type_Subtype_Disturbance’. Name the output of step 1.8.2 Permanent_Anthro_Disturbance.

	1.10. Habitat Suitability Index Score
	1.10.1 Using the Clip Raster tool, clip the Spring_HSI layer to the Analysis_Area_6000m layer (see step 1.3.1). Name this layer Current_Spring_HSI.
	1.10.2 Repeat step 1.10.1, replacing the Spring_HSI layer with the Summer_HSI and Winter_HSI layers. Name the outputs of step 1.10.1  Current_Summer_HSI and Current_Winter_HSI, respectively.
	1.10.3 Using the Zonal Statistics as Table tool, average all pixels of the Current_Spring_HSI layer within each map unit. Name the output table ZonalSt_Current_Spring_HSI.
	1.10.4 Repeat step 1.10.3, replacing the Current_Spring_HSI layer with the Current_Summer_HSI and Current_Winter_HSI layers. Name the outputs of step 1.10.1  ZonalSt_Current_Summer_HSI and ZonalSt_Current_Winter_HSI, respectively.
	1.10.5 Using the Join Field tool, join the MEAN field for the ZonalSt_Current_Spring_HSI table to the Map_Units_Dissolve layer.
	1.10.6 Change the field alias to indicate the table from which the field was joined:
	1.10.6(a) Open the attribute table of the Map_Units_Dissolve layer.
	1.10.6(b) Right-click the recently joined field ‘MEAN’ and click ‘Properties’.
	1.10.6(c) Change the Alias of the field to ‘Current_Spring_HSI’ and click ‘OK’.

	1.10.7 Repeat steps 1.10.5 and 1.10.6, replacing the ZonalSt_Current_Spring_HSI layer with the ZonalSt_Current_Summer_HSI layer with the ZonalSt_Current_Winter_HSI layers. In step 1.10.6, change the Alias of the field to ‘Current_Summer_HSI’ and ‘Curr...

	1.11. Distance to Lek (Breeding)
	1.11.1 Add the Dist_Lek layer to map project, if you haven’t already.

	1.12. Distance to Late Brood-Rearing (Breeding)
	1.12.1 Using the Clip Raster tool, clip the Dist_Brood layer to the Project_Area layer. Name this layer Current_Dist_Brood.

	1.13. Current Local-Scale Habitat Function
	1.13.1 Using the Raster Calculator tool, multiply the Current_Anthro_Disturbance layer by the Current_Spring_HSI layer, Current_Dist_Lek layer and the Current_Dist_Brood layer to calculate local-scale habitat function for breeding habitat using the fo...
	1.13.2 Using the Raster Calculator tool, multiply the Current_Anthro_Disturbance layer by the Current_Summer_HSI layer to calculate local-scale habitat function for late brood-rearing and winter habitat using the following expression. Name this file C...
	1.13.3 Repeat step 1.13.1, replacing the Current_Summer_HSI layer with the Current_Winter_HSI layer. Name the output of step 1.13.2  Current_Local_Winter.

	1.14. Projected Local-Scale Habitat Function
	1.14.1 Using the Raster Calculator tool, multiply the Projected_Anthro_Disturbance layer by the Current_Spring_HSI, the Current_Lek_Dist layer and the Current_Dist_Brood layer to calculate local-scale habitat function for breeding habitat using the fo...
	1.14.2 Using the Raster Calculator tool, multiply the Projected_Anthro_Disturbance layer by the Current_Summer_HSI layer to calculate local-scale habitat function for late brood-rearing and winter habitat using the following expression. Name this file...
	1.14.3 Repeat step 1.14.2, replacing the Current_Summer_HSI layer with the Current_Winter_HSI. Name the output of step 1.14.2  Projected_Local_Winter.
	1.14.4 Repeat steps 1.14.1 to 1.14.3 , replacing the Projected_Anthro_Disturbance layer with the Permanent_Anthro_Disturbance layer. Name the output of step 1.14.1 Permanent_Local_Breed. Name the output of step 1.14.2 Permanent_Local_LBR. Name the out...

	1.15. Export Data
	1.15.1 Using the Zonal Statistics as Table tool, average all pixels of the Current_Local_Breed layer within each map unit. Name the output table ZonalSt_Current_Breed.
	1.15.2 Using the Join Field tool, join the MEAN field for the ZonalSt_Current_Breed table to the Map_Units_Dissolve layer.
	1.15.3 Change the field alias to indicate the table from which the field was joined:
	1.15.3(a) Open the attribute table of the Map_Units_Dissolve layer
	1.15.3(b) Right-click the recently joined field ‘MEAN’ and click ‘Properties’.
	1.15.3(c) Change the Alias of the field to ‘Current_Breed’ and click ‘OK’.

	1.15.4 Repeat step 1.15.1 to 1.15.3 for all local-scale modifier layers created in steps 1.13 to 1.14.
	For debit projects: four or six zonal statistics tables (step 1.15.1) should be created and four or six joins (step 1.15.2) should be performed, one each for pre-project and post-project conditions (including term and permanent) for breeding and for l...
	For credit projects: two or four zonal statistics tables (step 1.15.1) should be created and joins (step 1.15.2) should be performed, depending on whether existing anthropogenic features, conifer cover, or late brood-rearing habitat will be modified b...
	1.15.5 Export the attribute table of the Map_Units_Dissolve layer to a text file named ‘Map_Unit_Data’:
	1.15.5(a) Open the attribute table of the Map_Units_Dissolve layer.
	1.15.5(b) Under ‘Table Options’ (            ) select Export and save as a .txt file. Name this file Map_Units_Data.
	1.15.5(c) When prompted to add the table to the current map, select ‘No’.


	1.16. Enter GIS Data into Credit or Debit Project Calculator
	1.16.1 Open the Project Calculator.
	1.16.2 Open a separate instance of Microsoft Excel.
	1.16.3 Add the Export Table to the blank workbook:
	1.16.3(a) In the Data Ribbon, ‘Get External Data’ section, select ‘From Text’.
	1.16.3(b) Navigate to the Export Table and Open the Export Table. When opening, specify the file is comma-delimited.

	1.16.4 Copy the relevant columns from the Export Table into the corresponding worksheets and columns in the Project Calculator. See Table 4 for a list of Export Tables generated during the Desktop Analysis that must be inputted into the Calculator.
	1.16.5 Review the desktop analysis results in worksheet 1.4 Review Desktop Results to ensure desktop analysis outputs were properly entered into the Calculator.

	1.17. Current and Projected Local-Scale Habitat Function for Meadow Map Units
	In this step, you will re-calculate the local-scale modifier layers (e.g. Current_Local_Breed) for meadow map units that are less than 0.5 acres or are of a shape that did not calculate a local scale habitat function in steps 1.13 and 1.14.
	1.17.1 In the Map_Units_Dissolve layer, select the Meadow map units that did not calculate a local scale habitat function or are smaller than 0.5 acres.
	1.17.2 Using the Buffer tool, buffer the Map_Units_Dissolve layer by 20m (Note: You may need to buffer by a greater distance, however we want to use the smallest buffer possible). Name this layer Map_Units_Meadows.
	1.17.3 Using the Zonal Statistics as Table tool, average all pixels of the Current_Local_Breed within each meadow map unit. Name the output tables as in ZonalSt_Current_Breed_Meadows.
	1.17.3(a) Repeat step 1.17.3 above for all local scale modifiers calculated in steps 1.13 – 1.14

	1.17.4 Using the Join Field tool, join the MEAN field for the ZonalSt_Current_Breed_Meadows table to the Map_Units_Meadows layer.
	1.17.4(a) Repeat step 1.17.4 above for all Zonal statistics layers calculated in step 1.17.3

	1.17.5 Export the attribute table of the Map_Units_Meadows layer to a text file named ‘Map_Unit_Meadows_Data’:
	1.17.5(a) Open the attribute table of the Map_Units_Meadows layer.
	1.17.5(b) Under ‘Table Options’ (            ) select Export and save as a .txt file. Name this file Map_Units_Meadows_Data.
	1.17.5(c) When prompted to add the table to the current map, select ‘No’.

	1.17.6 Add the Export Table to the blank workbook:
	1.17.6(a) In the Data Ribbon, ‘Get External Data’ section, select ‘From Text’.
	1.17.6(b) Navigate to the Export Table and Open the Export Table. When opening, specify the file is comma-delimited.
	1.17.6(c) Copy the relevant columns from the Export Table into the corresponding worksheets and columns in the Project Calculator. See Table 4 for a list of Export Tables generated during the Desktop Analysis that must be inputted into the Calculator.
	1.17.6(d) Add the local scale modifier data for the meadow map units to the corresponding map unit IDs in the Map_Units_Data excel file prior to entering the data into the HQT calculator.



	TIMING OF FIELD DATA COLLECTION
	FIELD MATERIALS REQUIRED
	DETAILED INSTRUCTIONS
	2.1. Conduct Site Reconnaissance
	2.2. [Repeat Steps 2.3 - 2.11 for each Map Unit]
	2.3. Complete Map Unit Datasheet
	2.4. Complete Resistance & Resilience Scorecard
	2.5. Complete Ability to Control Wildfire Scorecard
	2.6. Complete Lentic or Lotic PFC Checklist (if applicable)
	2.7. [Repeat Steps 2.8 - 2.11 for each Transect]
	2.8. Navigate to Transect and Begin Data Collection
	2.8.1 Establishing a Transect
	2.8.1(a) Navigate to a transect start point via hand-held GPS. Insert a chaining pin in the ground, and lay out or thread a 50-meter transect using the random bearing generated for that transect (see step 1.6 in Desktop Analysis). Pull the tape taut a...
	2.8.1(b) Transects will be named as followed: XXX-MU#-T#
	2.8.1(c) XXX is three letter abbreviation for project site, MU# is the map unit number, and T# is the transect number, all of which should be named based on information from the pre-field work desktop analysis.

	2.8.2 Photo Points
	2.8.2(a) Using a white board label it with the project site, date, transect name, and transect direction. Lean it next to the chaining pin it at the 0 meter mark of the transect.
	2.8.2(b) Align camera in direction of the transect so that the bottom of the white board is at the photo’s bottom center (Figure 11).
	2.8.2(c) Take photo and, if using GPS camera, name the photo using transect name.


	2.9. Daubenmire Plots
	2.9.1 Daubenmire Frame Placement
	2.9.1(a) Place the top of a Daubenmire frame on the left side of the transect line starting at the 10 meter mark (see Figure 12). The frame should be placed with the long side parallel to the transect.  Take care not to damage any vegetation. Repeat t...

	2.9.2 Grass and Forb Cover
	2.9.2(a) Record all grass and forb cover that falls within the plot using the following cover classes listed in Table 6. If the plant is rooted outside the plot, but its cover falls within the plot, those estimates should be counted towards cover. Do ...
	2.9.2(b) Identify cover for each of the following functional group categories:
	- PF = perennial forb (live cover only)
	- PG = perennial grass (live or residual)
	- IAG = invasive annual grass (live or residual)


	2.9.3 Forb Species Count
	2.9.3(a) For each Daubenmire plot, record the USDA PLANT code or scientific name for each forb species that are rooted within the plot, annual and perennial. Once all 5 plots are completed for a transect, tally and record the count of all forb species...
	2.9.3(b) Record all plant species encountered along the transect in the notes section of the datasheet.


	2.10. Distance to Sagebrush Cover
	2.10.1 Measure the distance to the nearest sagebrush, or sagebrush mixed shrub community, cover from the 30 m mark of the transect and record the distance in meters on the datasheet.
	2.10.1(a) Sagebrush or sagebrush mixed shrub community cover must have at least of 10% canopy cover in a minimum 30x30 m patch size with average height of 30 cm.
	2.10.1(b) If the transect is located within sagebrush cover, then record distance as 0 m.


	2.11. Line Intercept
	2.11.1 Shrub Canopy Cover
	2.11.1(a) You can begin at the 0 m or the 50 m mark for line intercept. For the entire length of the transect, record start and stop locations (in centimeters) for all shrub species intercepting the transect using the following categories:
	- Low sagebrush
	- Big sagebrush
	- Other

	2.11.1(b) Interceptions less than 5 cm are not recorded as canopy cover.
	2.11.1(c) If a gap is greater than 5 cm stop your intercept recording. Resume intercept once you reach canopy cover that is greater than 5 cm.
	2.11.1(d) Canopy cover for each shrub species is recorded, even if multiple species are overlapping.

	2.11.2 Sagebrush Height
	2.11.2(a) For each sagebrush plant intercepting the transect, record the tallest vegetative portion to the nearest cm. Do not include the inflorescence of sagebrush as height.


	2.12. Document Anthropogenic Features
	2.12.1 The anthropogenic features map developed in the pre-field desktop analysis should be ground-truthed on foot or in a vehicle.  Additional features that are identified should be marked on the map and digitized in the office in ArcGIS; similarly G...
	2.12.2 Newly identified features should be noted on the anthropogenic features datasheet for the project site.
	2.12.2(a) If features are marked on the map, be sure to attach map to the anthropogenic features datasheet.
	2.12.2(b) If features are marked using GPS, be sure to record GPS unit name and use the following naming code: XXX- # where XXX is the three letter abbreviation for project site, and # is a unique sequential number for each feature identified in the f...


	2.13. Input Data into Credit or Debit Project Calculator
	2.13.1 Open the Project Calculator.
	2.13.2 Enter the relevant data into the corresponding worksheets and columns in the Calculator. See Table 7 for a list of field datasheets completed during the field data collection that must be inputted into the Calculator.


	TOOL PREREQUISITES
	DETAILED STEPS TO CALCULATE CREDITS
	D2.1 Calculate Pre-Project Conditions
	3.1. Calculate Credits for Pre-Project Conditions
	3.1.1 Open the Credit Project Calculator.
	3.1.2 Review habitat function and functional acre scores based on current conditions presented in worksheet 3.2 Review Credit/Debit Amount to ensure data has been inputted accurately. If not, review Section 1: Desktop Analysis or Section 2: Field Data...
	3.1.3 Enter relevant WAFWA Management Zone and factors that determine the reserve account contribution into worksheet 3.1 Enter Baseline & Rsrv Acct.
	3.1.4 Conduct quality assurance effort by thoroughly reviewing the GIS process and products, baseline habitat function, current habitat function, current functional acres, current mitigation ratio and current credits generated values in worksheet Summ...


	D2.2 Define & Submit Project Design Information
	3.2. Complete Section I of the Management Plan
	3.2.1 Complete Section I of the Management Plan according to guidance provided in the form. For restoration or enhancement projects, use a draft Management Plan to outline design options for the project and describe expected outcomes. These design opt...

	3.3. Estimate Post-Project Credits
	3.3.1 In the Calculator, estimate post-project credits by entering projected post-project conditions based on project design options in the Management Plan into worksheet 2.7 Enter Projected Conditions.
	3.3.1(a) Projected post-project conditions are entered into the Projected Post-Project Habitat Function and Projected Post-Project Mitigation Ratio data entry columns. For cells left blank in these data entry columns, the current conditions are used f...

	3.3.2 Review the projected post-project credit calculations in worksheet Summary.
	3.3.3 Print the updated Credit Summary from worksheet Summary and copy/paste Credit Summary into the corresponding section of the draft Management Plan.


	D2.3 Implement Project, Refine Calculations & Submit
	3.4. Confirm or Refine Credit Calculations
	3.4.1 Implement the project and repeat the credit calculation if the project was not consistent with the draft Management Plan. Modify the Calculator and repeat steps in the Desktop Analysis if necessary. This is the final, official credit calculation...

	3.5. Determine Reserve Account Contribution
	3.5.1 Enter the area-weighted Resistance and Resilience scores from the Score Sheets completed in step 2.4 into worksheet 3.1 Enter Baseline & Rsrv Acct of the Calculator.
	3.5.2 Enter the area-weighted Ability to Control Wildfire Score Sheet score for the credit project.
	3.5.3 Complete the Competing Land Use assessment and input contribution percentage from Table 8 for projects on private land into Worksheet 3.1 Enter Baseline & Rsrv Acct of the Calculator. See the Management Plan for information necessary to complete...

	3.6. Determine Credit Release Schedule
	3.6.1 Review the pre-project credit calculation to the expected post-project credit calculation in worksheet Summary.  Use this information to fill out the Credit Release Schedule in Section II of the Management Plan.

	3.7. Calculate Financial Assurances
	3.7.1 Complete the management actions table in Section III of the Management Plan to estimate the cost for long-term management of the credit project. Use this section to determine the amount required for financial assurances for the project. Fill out...

	3.8. Set Verification Schedule
	3.8.1 Complete the independent verification schedule in Section III of the Management Plan.

	3.9. Complete Participant Contract
	3.9.1  Fill out and sign the Participant Contract.



	DETAILED STEPS TO CALCULATE CREDIT OBLIGATION
	B2.1 Determine Credit Obligation Amount
	3.10. Establish Verification Contract
	3.10.1 Complete a Verification Contract with the Credit Buyer.

	3.11. Estimate Credit Obligation
	3.11.1 Open the Debit Project Calculator.
	3.11.2 Review all tabs to ensure data has been inputted accurately. If not, review Section 1: Desktop Analysis or Section 2: Field Data Collections Methods for instructions.
	3.11.3 In the Debit Project Calculator, review preliminary credit obligation calculation in worksheet Summary. This is the pre-implementation credit obligation estimate.

	3.12. Verify Debit Estimates
	3.12.1 If field data was collected by the Credit Buyer, verify that field data collection was completed accurately.

	3.13. Verify Post-Project Conditions
	3.13.1 After the project has been implemented, verify that project design plans were followed and that the original credit obligation estimate is still accurate. If not, repeat Desktop Analysis steps necessary to recalculate credit obligations based o...

	3.14. Purchase Credits
	3.14.1 The Credit Buyer will be provided a list of credit projects that could meet the Credit Buyer’s credit obligation. The Credit Buyer then selects one or more potential credit projects and contacts the Credit Developer. The Credit Developer and Cr...
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